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Chapter 1 Essential Preparation
Overview
QuickBooks Point of Sale is an advanced inventory tracking and point of sale 
program designed to help you effectively manage your retail store(s). As you order, 
receive, and sell merchandise, your inventory quantities and costs are automatically 
updated and you are building sales history information that you can use to help you 
better run your store(s) and serve your customers, while also maximizing profit. 

The Point of Sale software that you purchased contains three separate levels of the 
program, each with a specific set of features. This allows you to purchase and use 
only those features that you need, without having to pay for advanced features you 
won't use. When you made your purchase, you bought a license to one of the three 
levels. 

As your business grows and you need the additional features of a higher level, you 
can simply "unlock" to the next level with a phone call. No reinstalling, waiting for 
new CDs in the mail, or starting over; upgrading is easy and immediate. 

Refer to Appendix B in the Point of Sale User’s Guide for a complete list of the 
features at each level.

Point of Sale allows up to ten networked workstations to run the program 
simultaneously within a single store. With the Pro Multi-Store level, you can 
efficiently manage up to ten stores, with centralized purchasing, inventory control, 
and reporting. 

In either a multi-workstation or multi-store configuration, each workstation that is 
concurrently accessing the Point of Sale company data must have a separately 
purchased user license. Refer to  Point of Sale Licensing (page 9) for more 
information.

Integration with QuickBooks Financial Software
Point of Sale is designed to be integrated with QuickBooks Financial Software. Point 
of Sale tracks your daily point-of-sale business: purchasing, receiving, inventory 
tracking, and sales, and QuickBooks Financial Software tracks your financial data.

Exchanging information between the two programs is referred to as Financial 
Exchange and can significantly reduce your workload because the sales activities you 
track in Point of Sale, can be transferred directly into QuickBooks. There is no need 
to enter information twice!
QuickBooks Point of Sale 1



Chapter 1:  Essential Preparation
Several options are available for you to customize how your Point of Sale data is 
transferred to QuickBooks so that it works for your particular business model and for 
how you prefer to have your retail activities reported.

Offer Customers the Convenience of Credit, Debit, and Gift 
Card Payments
You can authorize and process credit, debit, and gift card transactions within Point of 
Sale and, optionally, boost store traffic by offering cash back to your customers on 
PIN debit transactions. Integrated processing means you never have to enter 
transactions twice. 

Additional information and instructions for the integration of credit, debit, and gift 
card processing is provided later in this guide and within the Point of Sale Setup 
Interview or you can call 800-926-9066.

Integrated credit and debit card transactions require an account with the QuickBooks 
POS Merchant Service, an optional, fee-based service. A card reader and/or PIN pad 
device is also required for best swipe rates or to process PIN debit transactions. 
Integrated gift card transactions require an account with the QuickBooks POS Gift 
Card Service, an optional, fee-based service.

What you will learn in this chapter:
• The recommended sequence for installing and configuring Point of Sale
• The minimum system requirements to use Point of Sale
• Point of Sale terminology
• What’s important about the Server Workstation
• How Point of Sale licensing works with networked computers
• What information your should have available before you begin
• How to plan for Point of Sale hardware
• How to get additional help if needed

 Windows User Profile Created

With Point of Sale 5.0, additional security steps have been taken to prevent unauthorized 
access to your company data. Part of this protection included creating a user profile in 
Windows called QBPOSDBSrvUser. This ensures that your company information can only 
be accessed through Point of Sale.
2 QuickBooks Point of Sale



Recommended Installation Sequence
Recommended Installation Sequence
The checklist below outlines the recommended sequence for installing and 
configuring Point of Sale. You do not have to install in this sequence, but it is 
intended to help get up and running in the most efficient manner possible. 

Upgrading from a previous version? If you are not making significant changes in 
your configuration (e.g. not adding workstations, stores, or just beginning to use 
QuickBooks), review this chapter and then skip to  Chapter 5 Upgrade from 
Previous Version (page 47), which includes simplified upgrade instructions. 

New Pro Multi-Store Users: It is strongly recommended that you read  Chapter 7 
Configure Multiple Stores (page 69) before beginning, When ready, return here and 
follow this procedure, starting at your Headquarters store.  

  

1. Plan for your Installation
Refer to the remaining sections of this chapter to: 

Make sure you meet minimum system requirements, pg. 5
Familiarize yourself with Point of Sale terminology, pg. 6
Decide on a location for the Point of Sale Server Workstation, pg. 7 and 
review how Point of Sale network licensing works, pg. 9 
Collect information needed for setup, pg. 10
Review the hardware planning section, pg. 11
Become familiar with help and learning resources, pg. 13

2. Install QuickBooks Financial Software and Configure 
your QuickBooks Company File

If you are a new or existing user of QuickBooks, and plan to integrate the two 
programs now, refer to Chapter 6 for instructions to:

Install QuickBooks, or confirm your existing installation, meets one of the 
three configuration options, pg. 57
Create your financial company file, if necessary pg. 60
Review your financial company file for necessary settings, pg. 62
3
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3. Install the Point of Sale Server Workstation and Create 
your Point of Sale Company Data

Refer to Chapter 2 for instructions to:

Install Point of Sale on the Server Workstation, pg. 16
Connect workstation hardware and install drivers, pg. 16
Create your Point of Sale company data file, pg. 17
Complete the Setup Interview, pg. 18 to:

Configure basic program preferences and customize features
Learn about and sign up for Merchant and Gift Card Services
Set up hardware for use with Point of Sale
Establish the connection to your QuickBooks software

4. Install Point of Sale on Client Workstations 
Refer to Chapter 3 for instructions to:

Review multi-workstation guidelines, pg. 23 
Install Point of Sale, pg. 24
Connect to the company data on the Server Workstation, pg. 25
Configure hardware and other workstation preferences, pg. 25
Merge license with Server Workstations, pg. 26

5. Complete Essential Getting Started Tasks
Refer to Chapter 4 for basic instructions to:

Complete your Point of Sale setup, pg. 27
Import existing data, pg. 32
Add vendors, items, and customers, pg. 37
Receive merchandise and print tags, pg. 40
Make a sale or return, pg. 43
Run the End of Day procedure, pg. 46
4 QuickBooks Point of Sale



Minimum System Requirements
Minimum System Requirements
Minimum System Configuration

• 500 MHz Pentium III (or equivalent) computer with 256MB of RAM  
(Recommended: 1 GHz Pentium III with 512 MB of RAM)

• Windows® 2000/XP
• 250 MB of disk space for installation; disk space required increases as your 

data file grows (Recommended: 500 MB of disk space)
• 256-color SVGA video
• 800 x 600 resolution with small fonts; optimized for 1024 x 768 resolution 
• 2x CD-ROM 
• Internet Explorer 6.0 required (provided on CD, requires an additional 70 

MB disk space)
• Microsoft .NET Framework 1.1, SP 1 required (provided on CD, requires an 

additional 23MB disk space)
• Printer supported by Windows 2000/XP 
• (Optional) QuickBooks-approved retail hardware. 

Details available at www.quickbookspos.com

Integration with Other Software
• QuickBooks Financial Software integration requires QuickBooks Pro or 

Premier Editions (2003-2006) or Enterprise Solutions (Version 2.0-6.0) 
• Data import/export requires Excel 2000, 2002, or 2003   

Multi-User & Multi-Store Configuration
• Multi-user (2-10 workstations in one store) is optimized for Windows 2000 

Server or Windows Server 2003 client-server networks, and Windows 2000/
XP peer-to-peer networks. Novell NetWare is supported, but not 
recommended.

• In either a multi-user or multi-store configuration, each workstation 
concurrently running Point of Sale must have a separately purchased user 
license, and every copy of Point of Sale must be the same version and level.

QuickBooks POS Merchant Service 
• Optional fee-based service, additional terms & conditions apply
• Requires a merchant account through QuickBooks POS Merchant Service, 

provided by Innovative Merchant Solutions, LLC, an Intuit company. 
5
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Chapter 1:  Essential Preparation
Application approval and fees apply. Details available at 
www.quickbooksms.com/posms

• Credit card reader recommended and printer required for credit and debit 
transactions. PIN pad required for PIN debit transactions

• Internet connection or modem and phone line required

QuickBooks POS Gift Card Service 
• Optional fee-based service, additional terms & conditions apply
• Requires a gift card service account through QuickBooks POS Gift Card 

Service, provided by Innovative Merchant Solutions, LLC, an Intuit 
company. Application approval and fees apply. Details available at 
www.quickbooksms.com/posgcs

• Gift cards purchased separately
• Internet connection or modem and phone line required

Point of Sale Terminology
Familiarizing yourself with the following terminology before beginning will help you 
understand the various procedures and Point of Sale features discussed. 

Point of Sale – The QuickBooks Point of Sale program.

QuickBooks – The QuickBooks Financial Software program.

Company Data/Company File – The data file(s) that you create and work with in 
Point of Sale and in QuickBooks. In Point of Sale, your file is called company data 
and stores your point-of-sale information. In QuickBooks, your financial information 
is called a company file. Financial Exchange links the two files so that data can be 
shared. 

Server/Client Database – A database model used by Point of Sale, where one 
workstation (the Server) stores the company data which is accessed by all other 
workstations (Clients) running Point of Sale on the same network. 

Server Workstation – The workstation that holds your Point of Sale company data 
and the database applications that allow Point of Sale to work with the company data. 
You install to this workstation first in a multiple workstation configuration. Only the 
Server Workstation can perform certain data-related activities, such as creating 
company data and exchanging information with QuickBooks. If you have only one 
workstation, then it is a Server Workstation.
6 QuickBooks Point of Sale
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About Server and Client Workstations
Client Workstations – Additional workstations on a network that access the Server 
Workstation to work with the Point of Sale company data. There may be up to nine 
client workstations in a networked installation (ten total, including the Server 
Workstation). 

Financial Exchange – The exchange of information between Point of Sale and 
QuickBooks, typically run as part of the End of Day procedure from the Point of Sale 
Server Workstation. 

Account Mappings – Refers to the “linking” instructions of various Point of Sale 
fields, payment types, or transaction information to the appropriate accounts in your 
QuickBooks Chart of Accounts. These account mappings determine how Point of 
Sale data is posted to QuickBooks. 

Store Exchange – The exchange of Point of Sale company data between the Server 
Workstations at Headquarters and remote stores in a Pro Multi-Store configuration.

User License – An entitlement or license to use Point of Sale on one computer. 
Having multiple user licenses allows multiple computers (workstations) to access the 
Point of Sale company data at the same time.

About Server and Client Workstations
If you have only one workstation in your store, then it must be installed as a Server 
Workstation. The discussion below does not apply to you, though you may want to 
review it for future consideration if you add additional workstations.

If you have multiple workstations, this information will help you decide which of 
your workstation should be made the Point of Sale Server Workstation. 

Your choice of a Server Workstation is important, because:

• Only the Server Workstation can perform the following Point of Sale tasks:
Financial Exchange with QuickBooks
Creation, conversion, or renaming of a Point of Sale company data
Online registration and synchronization of license information with 
Intuit servers
Store Exchange of information (in a Pro Multi-Store configuration)

• The Server Workstation stores your Point of Sale company data and the 
database access applications. All other workstations (Clients) access the 
company data on this workstation.

• The Server Workstation can also perform all other Point of Sale tasks.
7



Chapter 1:  Essential Preparation
Ideally, the Server Workstation is your fastest, most powerful computer with the 
largest hard drive, most memory (RAM), and equipped with a modem, Internet 
connection, or removable media devices for information exchange. 

Consider the following when deciding the location of the 
Server Workstation:

• Where do you want your QuickBooks Financial Software installed? 
Only the Server Workstation can run Financial Exchange with QuickBooks. 
Installation options with QuickBooks are discussed in Chapter 6 Integrate 
with QuickBooks (page 55).

• Do you want your sales associates to have access to the Server 
Workstation? 

• Do you have a single or multiple Point of Sale user licenses? Point of Sale 
licensing on a network is discussed in  Point of Sale Licensing (page 9).

• Where do you have access to the Internet?

Once the Server Workstation is installed and your company data file has been created, 
each additional workstation within a store is then installed as a Client workstation and 
accesses the company data file over the network. Client computers have only the 
Point of Sale program files installed locally. 

  IMPORTANT: Dedicated Network Server Not Recommended 

We do not recommend using a dedicated network server to hold your Point of Sale 
company data. Significant performance degradation may result if the company data is not 
on the same computer as the database application files (installed with Server Workstation).

Network

Server Workstation
• Point of Sale program files
• Point of Sale company data
• Database applications
• Communicates with QuickBooks

Client Workstations
• Program files only
• Access company data 

across network
8 QuickBooks Point of Sale



Point of Sale Licensing
Point of Sale Licensing 
When you purchased Point of Sale, you were in fact purchasing one (or more) user 
licenses. You can only have as many concurrent computers accessing Point of Sale as 
you have user licenses.

One License, Multiple Workstations
All of the networked computers in a store share a "store license" which is managed by 
the Server Workstation and may include from one to ten user licenses (based on your 
purchase). The Server Workstation ensures that no more than the licensed number of 
users are using Point of Sale at any one time.

For example, say you want to use a point-of-sale workstation in the front of the store 
during business hours, but want to use a networked back-office workstation in the 
evenings to create purchase orders and exchange data with QuickBooks. In this 
example, only a single copy (with one user license) of Point of Sale is required. It 
would be installed on the back-office computer as the Server Workstation and the 
front computer as a Client Workstation, using the same license number. Either 
workstation can access Point of Sale, but only one at any given time. If you require 
that multiple workstations run Point of Sale at the same time, you would need to 
purchase additional user licenses.

Benefits of this Licensing Structure
• Only one workstation (the Server Workstation) must register the Point of 

Sale software
• You can use multiple workstations for sale lanes or specialized roles 

(purchasing, receiving, etc.)
Use a single user license that is accessible via multiple workstations, but 
only one at a time, or
Use multiple workstations at the same time provided multiple user 
licenses have been purchased

• In a Pro Multi-Store installation, you can transfer user licenses from one 
store to another, or temporarily use a store’s user license to run Point of Sale 
(installed as a client) on a laptop you take store-to-store.

 Multiple Workstations

All installations on a network must be the same level of Point of Sale, i.e. Basic, Pro, or Pro 
Multi-Store.
9



Chapter 1:  Essential Preparation
Merging License Numbers
If you purchase and install additional copies of Point of Sale with different license 
numbers on Client Workstations, you must merge them with the Server Workstation's 
store license. After merging, the new workstation shares the same license as the 
Server Workstation and the Client Workstation’s original license number is 
deactivated.

The Server Workstation, in turn, synchronizes its license information with Intuit's 
licensing servers to reflect the fact that an additional user license has been added. The 
new user license is not available for use until synchronization is completed. Point of 
Sale will prompt you to synchronize when needed.

Collecting Necessary Information 
As you configure Point of Sale, and optionally QuickBooks, you will be asked to 
enter certain information about your company. This information is used to set up your 
company file in each program. 

We suggest you have the following information available before beginning:

• Name and addresses, phone numbers, web sites, etc. for each store in your 
company

• Names, addresses, contact information, account numbers, balances, etc. for 
existing vendors, customers, and employees

• Current on-hand counts, costs, and prices for existing inventory items
• Applicable sales tax rate(s) and the name of the agency to which they are 

paid
• Pro Multi-Store Users: The Point of Sale License Numbers, e-mail 

addresses, mapped drive path, or removable media information for the 
Server Workstation at each store

 Tip: Importing Data Saves Time

Point of Sale offers two ways to import existing customer, vendor, and item information. 
Importing existing data can save many hours of tedious re-entry. Both of these import 
methods are discussed in Chapter 4 Essential Startup Tasks (page 27).
10 QuickBooks Point of Sale



Planning for Point of Sale Hardware 
Planning for Point of Sale Hardware 
Point of Sale has been designed to work seamlessly with select industry-leading retail 
hardware. The addition of dedicated point-of-sale hardware to a Point of Sale system 
creates a more professional retail environment, instilling trust and confidence in 
customers while also making your operation more efficient.

Point of Sale hardware, in multiple colors and port configurations, is available 
directly from and supported by Intuit or you can purchase compatible hardware from 
other sources. Refer to Appendix D in the Point of Sale User’s Guide for the list of 
compatible hardware

Planning for hardware at your Point of Sale workstations is a three-part process:

1. Answer hardware-related questions and gather information:
• How many workstations at how many locations will run Point of Sale? What 

are the intended activities at each workstation?
• What hardware and connection ports are needed for each workstation? 
• Do existing PCs meet system requirements and have the necessary 

connection ports?
• Is existing hardware on the list of compatible hardware? 
• Can hardware be shared among workstations or locations, e.g. one tag 

printer at a central receiving location, for example?
The illustration below will help you identify the various port types used for 
typical Point of Sale hardware.

Parallel Printer Port 
Receipt Printer 
Dedicated Tag Printer 
Report Printer

Serial or COM (RS-232/DB-9) Port 
Pole Display

Universal Serial Bus (USB) Ports 
Portable Data Terminal (PDT) 
PIN pad 
Most equipment types available w/USB connections

PS2 Keyboard Port 
Barcode Scanner 
Card Reader
11



Chapter 1:  Essential Preparation
2. Determine, purchase, and install needed port upgrades or new workstation PCs:
• If more USB ports are needed, you can purchase a powered USB hub from 

your local office supply or computer store 
3. Determine, purchase, and install dedicated Point of Sale hardware:

• Install Point of Sale before attaching and installing hardware
• Read instructions included with each piece of hardware.
• Specify installed hardware when you reach the equipment section of Setup 

Interview or in workstation preferences
Careful survey of existing hardware compatibility, as well as future needs, will help 
identify the equipment purchases required, eliminating implementation bottlenecks. 

Typical Hardware Configuration

Point of Sale Office Receiving/Floor

Role: Ring up sales, take 
orders, and capture 
customer information.

Manage inventory, 
purchasing, reports, and 
data exchange with 
financial software.

Receive and transfer 
merchandise, perform 
physical counts, and 
print tags.

Hardware: • 40-Column Receipt 
Printer

• Cash Drawer
• Credit Card Reader/

PIN pad
• Barcode Scanner
• Pole Display (required 

in some areas)

• Windows Report 
Printer (laser or ink 
jet)

• Barcode Scanner

• Barcode Scanner
• Dedicated Tag 

Printer
• Portable Data Ter-

minal (PDT)
12 QuickBooks Point of Sale



Need Help Getting Started?
Need Help Getting Started?
Free, Self-Service Support
Support Website: Provides a Knowledge Base of answers to frequently asked Point 
of Sale questions. Visit www.quickbooks.com/support. 

Community Message Boards: Provides a gathering place for users and experts to 
share ideas, ask questions, and provide solutions to one another. Visit 
www.community.quickbooks.com/pos.

Find a QuickBooks Point of Sale Specialist in Your Area
Locate a Certified Point of Sale ProAdvisor who can help you set up Point of Sale, 
answer questions, and/or provide training and support to you or your employees. 
Choose among Certified Point of Sale ProAdvisors—CPAs, accountants, small 
business advisors, trainers, or computer consultants—who have been tested on both 
QuickBooks and Point of Sale. To find the Point of Sale specialist nearest you, visit 
www.quickbooks.com/findadvisor.

Make sure that in Step 2 of your search criteria you select a ProAdvisor who is 
Certified in QuickBooks Point of Sale. Fees apply and are set by the QuickBooks 
ProAdvisor®.

Point of Sale Phone Support
Call (800) 348-0254. Several live options are available. Fees apply after an initial 30-
day free support period. For details, call 6 am to 6 pm Monday - Friday, or 7 am to 4 
pm Saturday - Sunday, PST*.

*Excluding occasional downtime for system and server maintenance, company 
events, observed U.S. holidays, and events beyond our control.

Merchant and Gift Card Services Support
For information about applying for an account with either service, call 800-926-9066.

For support with an existing account, call 800-558-9558, 24 hours a day, 7 days a 
week.
13
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Chapter 1:  Essential Preparation
Learning to Use Point of Sale
After you have installed, Point of Sale offers two ways for you to learn and train your 
employees to complete retail tasks. 

Using the Learning Center
Visit the Learning Center to watch and interact with “Show Me” instructional videos 
that teach basic program tasks visually. 

The Learning Center is automatically launched after you complete the Setup 
Interview, but can be accessed anytime later by selecting LEARNING CENTER from the 
Help menu. 

Using Practice Mode
Practice mode provides a way to train employees or to try out the features at a higher 
level of Point of Sale, without affecting your real company data. Practice mode allows 
you to try almost all program features, except authorizing or settling credit card and 
debit transactions, running Financial Exchanges with QuickBooks, and backing up or 
restoring the company data.

To use practice mode:
1. Close all open windows.
2. Select PRACTICE QBPOS from the File menu.
3. Select the data you want to practice with, either the same data you last used (if this 

is your first time accessing practice, this choice loads sample sporting goods data) 
or a copy of your own real data (does not affect your real data). 

4. Choose a practice level and then select OK. 
Basic users can select to practice in Pro or Pro Multi-Store levels, and Pro users 
can choose to practice in Pro Multi-Store level, to try out the added features in a 
higher level. 

5. When done, select EXIT PRACTICE from the File menu.
While in practice, the words "Practice Mode" flash in the title bar and the status bar is 
displayed in a bright yellow color. 

   Dates in Practice Mode

While in practice mode, Point of Sale sets today’s date to December 15, 2007. 
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Chapter 2 Install the Server Workstation
Before beginning this chapter, you should have:
If on a network, decided which computer to make the Server Workstation, based 
on the information in Chapter 1 Essential Preparation (page 1). 
Installed and configured your QuickBooks company file, on this or another net-
worked computer according to the instructions in  Chapter 6 Integrate with 
QuickBooks (page 55)

In this chapter, you will:
• Install Point of Sale on the computer you have decided to make the Server 

Workstation
• Connect any Point of Sale hardware you will use with this workstation
• Create your Point of Sale company data file and assign a workstation 

number
• Register your Point of Sale software
• Complete the Setup Interview to configure basic program settings 

   Windows Security Affects Point of Sale Rights

You must have Windows Administrator rights to install Point of Sale. Once installed, users at 
the User, Power User, or Administrator levels can run Point of Sale. To manage your 
Windows security levels, go to the Users section of My Computer (name may vary with 
Windows version).

   Installing Company Data File to a Dedicated Server Not Recommended

The use of a dedicated server with Point of Sale 5.0 is not recommended. Your fastest 
computer, with the most memory and largest hard drive, should be used as the server as 
well as performing point-of-sale activities. This workstation has the database applications 
installed to it. Placing the company data file on a dedicated server separate from this 
workstation will result in performance degradation.

  Note: Installed Firewalls May Block Access to Point of Sale Company Data

If you have a firewall installed on your system, it may block communication between Point of 
Sale and your company data and when attempting to complete certain other Point of Sale 
activities that require an Internet connection. If your firewall displays a warning message 
about this communication, we strongly recommend that you choose the option to always 
allow this access. In the case of the firewall integrated with WIndows XP, Point of Sale will 
ask you if you want it to automatically configure the firewall. Again, we strongly recommend 
answering yes. For more information about firewalls, how they can affect Point of Sale 
activities, and how to configure them, refer to Appendix B Configuring Firewalls (page 
85).
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Chapter 2: Install the Server Workstation
Installing Point of Sale
To install Point of Sale on the Server Workstation:

1. Close all running programs, except Windows.
2. Put the Point of Sale CD into your CD-ROM drive. 

The Install Wizard will launch automatically (if it doesn’t, browse to the 
SETUP.EXE file on the CD and double-click it to start the installation). 

3. Follow the on-screen prompts to install the program files to your computer: 
• Point of Sale 5.0 requires that Microsoft .NET Framework 1.1, SP 1 be 

installed. You will be prompted to install this program if necessary. When 
done, you may have to manually restart the Point of Sale installation from  
Step 2.

• Enter the License and Product numbers from the CD holder or that you were 
given when you purchased Point of Sale. 

• Read and accept the license agreement.
• Select SERVER as the Installation Type. 

If you want to specify the installation path and other setup options, select 
CUSTOM as the Installation Type and then select SERVER in the Install Options 
window. Accept the default installation folder (recommended) or browse to 
an alternate location. Note: For best performance install to the local hard 
drive and not to a dedicated network server.

4. Follow the prompts to complete the installation.
If you have purchased hardware to install to this workstation, do not launch Point of 
Sale at this time. 

Connecting Hardware
Follow the instructions provided with the hardware to connect and install it to your 
workstation.

If you purchased hardware from Intuit, note that the hardware setup instructions 
include a section titled “Configure Point of Sale.” Do not complete those steps now.

You will configure Point of Sale for the attached hardware after you create your 
company data file and as you complete the Setup Interview (or in Point of Sale 
workstation preferences after completing the interview). 
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Creating your Company Data
Creating your Company Data
To create your Point of Sale company data:
1. Launch Point of Sale.
2. When prompted, select a workstation number. Choose any of the available 

workstation numbers from the drop-down list. After assigning a workstation 
number, Point of Sale displays the options for creating your POS company data.
• Watch an Overview Tutorial of the program
• Use Practice mode to try out the Point of Sale features
• Create a new company data file
• Open an existing Point of Sale 5.0 company data file (applicable on 

reinstallation at a later date)
3. Select CREATE NEW COMPANY DATA.
4. Enter a unique name for your company data file and select OK.

Point of Sale creates your new company data file. This may take a few minutes.
5. Select OK to close the confirmation window, when displayed.

Registering Point of Sale
You will be prompted to register the Point of Sale software each time you start the 
program until registration has been completed. The software must be registered or it 
will cease to function on the 31st day after installation. 

To register Point of Sale:
1. From the Product Registration screen, select REGISTER NOW. 

• If you are connected to the Internet, an online registration form is displayed.
• If you are not connected to the Internet, the phone registration window is 

displayed. Dial the number listed to register.
2. Follow the online prompts or the instructions provided by the phone agent to 

complete the registration. 
You are encouraged to register promptly. Besides keeping your software functional, 
registration provides other valuable benefits including notification of Point of Sale 
updates, enhancements and fixes, and access to certain online features.Your license 
and product numbers can be viewed after registering by selecting HELP  ABOUT 
POINT OF SALE. You will need to provide these numbers if you contact Intuit for 
support, to purchase more user licenses, or to unlock to a higher level.
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Chapter 2: Install the Server Workstation
Completing the Setup Interview
The Setup Interview is automatically launched to assist you in configuring the 
program by asking a series of easily answered questions. 

The information you provide in the interview is used to set up basic program options, 
customize features, set up hardware, and optionally, to sign up for the QuickBooks 
POS Merchant and Gift Card Services and connect to your QuickBooks Financial 
Software. 

 As you complete the interview, keep in mind:

• If you are not prepared to complete a section, skip that section until later.
• You can return to the interview at any time to change most choices by 

selecting SETUP INTERVIEW from the File menu.
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Completing the Setup Interview
• The program settings configured during the interview can also be reviewed 
or revised later by accessing COMPANY or WORKSTATION PREFERENCES from 
the Edit menu .The preference windows are also where you can set up more 
advanced options that are not covered in the interview.

• For more information on a particular topic, select from the blue help links 
available on each page. 

The remainder of this chapter provides a brief overview of the interview.

Your Company
Enter your company name and contact information. This information is printed on 
documents created in Point of Sale. 

If you specify the type of retail business you operate, Point of Sale will create a set of 
merchandise departments suitable for your business, saving you some setup time. 
Later, you can add, rename, or delete the default departments to better fit your needs.

If you are a Pro-level user, Point of Sale will also create some standard inventory style 
templates for your use based on your business type.

Other Stores
This section applies to Pro Multi-Store users only, and is covered in detail in Chapter 
7 Configure Multiple Stores (page 69).

Customize Features
Use this page to remove Point of Sale features that you do not plan to use. Clearing 
the check-box for a feature removes the menu options, fields, and windows for that 
feature throughout the program, leaving your work screen less cluttered and more 
efficient for the activities important to you. Read an explanation of each feature listed 
by selecting More Info to the right of the feature.

Sales Tax
If you charge sales tax, enter your sales tax rate and the agency to which you make 
your tax payments. If you need to collect different tax rates based on the type of 
merchandise being sold or where the customer lives, enter the rate you most often 
charge here and then later, after completing the interview, you can set up other tax 
rates and advanced options in company preferences.
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Chapter 2: Install the Server Workstation
POS Merchant Service/Gift Card Service
Use the links on this page to learn about and sign up for an account with either or both 
the QuickBooks POS Merchant Service and the QuickBooks POS Gift Card Service, 
both provided by Innovative Merchant Solutions, LLC (IMS), an Intuit company.

Integrating these services means that credit, debit, and gift card sales can be 
processed, settled, and reported, all from within Point of Sale. Key benefits of this 
service include:

• No duplicate data entry. All your credit, debit, and gift card sales are handled 
directly on your Point of Sale workstation. 

• Choice of modem or secure Internet connections to communicate with the 
services.

• Availability to offer cash back on PIN debit transactions.
You can set up an account online (requires Internet connection) or by phone at 800-
926-9066. Once you have signed up for the account, you will be e-mailed your 
account number(s), which can be entered on this interview page or in company 
preferences later. 

When you receive your Account Number(s), refer to Appendix A Merchant & Gift 
Card Services (page 79) for instructions on entering the account number in Point of 
Sale company preferences, set up communications, and set other service options. 

Printers & Eqipment
Use this interview page to configure this workstation to work with point-of-sale 
hardware bundles, or individual hardware components, such as a touchscreen, receipt 
printer, cash drawer, tag printer, modem, credit card reader, PIN pad, and pole display.

If you purchased a hardware bundle, select it at the top of the list of hardware. This 
selection will automatically select the correct models of hardware for the various 
included components.

Select the SET UP or PROPERTIES button for each individual piece of hardware to open 
the Set Up dialog for each. Add or verify the correct models are listed and, where 
available, use the test button to make sure the equipment is functioning properly.

More help is available for setting up each component on the individual dialogs.
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Completing the Setup Interview
Use with QuickBooks
Specify on this page if you are going to integrate with QuickBooks and, if ready to 
begin sharing data, you can establish the connection between the programs.

If you are going to connect now:
1. Leaving the Point of Sale interview open, launch QuickBooks and open your 

financial company file (sign in as an Administrator or as a user with full 
Administrator rights).

2. Switch back to Point the Sale and select CONNECT TO QUICKBOOKS NOW.
The QuickBooks Connection Wizard is launched and locates your QuickBooks 
company file. QuickBooks displays a certificate window, asking you if you want 
to allow Point of Sale to access your company file. 

3. Answer YES, ALWAYS; ALLOW CONNECTION EVEN IF QUICKBOOKS IS NOT RUNNING.
Your options on this page may vary, depending on the specific version of 
QuickBooks you have. If you do not have the option to allow access even when 
QuickBooks is not running on this screen, you can set this preference later in 
QuickBooks. (The automatic login option is not available if you are using the RDS 
configuration to connect.)

4. Answer YES or OK on the confirmation windows QuickBooks displays.
5. Follow the remaining prompts to complete the connection.
You are now ready to send data between the two programs! Point of Sale will 
reconnect to this same company file anytime it is needed.

   Equipment Must be Configured Separately for Each Workstation

If you have multiple workstations, return to this section after installing each and set up the 
equipment unique to that workstation. Optionally, equipment can be set up in workstation 
preferences (from the Edit menu, select PREFERENCES WORKSTATION, and then select the 
hardware type from the left-side preference list). 

   Selecting Print Templates

Point of Sale comes with several pre-designed print templates for each document and tag 
type. You can select from these templates on the Print Options page in workstation 
preferences after completing the interview. You will be prompted to select a template the 
first time you go to print a document or tag if you haven’t made your selections prior to that 
time. 
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Chapter 2: Install the Server Workstation
Complete Page
Congratulations! You’ve completed the interview and are ready to begin using Point 
of Sale on your Server Workstation.

This page of the interview has links to helpful getting started information and learning 
tools. 

Take a few minutes to explore the program, but don’t forget to come back to install 
additional workstations and to read an overview of the essential tasks that will get you 
up and running fast! 
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Chapter 3 Install Client Workstations
Before beginning this chapter, you should have:
Verified that your network is functioning properly and meets the  Minimum 
System Requirements (page 5)
Familiarized yourself with  Point of Sale Licensing (page 9) for a networked 
installation
Installed Point of Sale on the Server Workstation and completed the Setup Inter-
view according to the instructions in Chapter 2 Install the Server Worksta-
tion (page 15)

In this chapter, you will:
• Review multi-workstation guidelines
• Install Point of Sale on Client workstations and assign a workstation number 

to each
• Connect and configure Client workstation hardware
• Connect to the company data file on the Server Workstation
• Merge Client licenses with the Server Workstation license (if necessary)

Multi-Workstation Guidelines
Point of Sale can be networked to allow up to ten networked workstations concurrent 
access to the company data within a store; one Server Workstation and up to nine 
Client workstations. 

The following general guidelines apply to multi-workstation configurations of Point 
of Sale:

• Only one Server Workstation can be installed on a network
• Each workstation must have the same version and level of Point of Sale
• If multiple workstations will concurrently run Point of Sale, each must have 

a separate user license (all user licenses get merged)
• Client workstations hold only program files, they access the Point of Sale 

company data on the Server Workstation to complete program tasks
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Chapter 3:  Install Client Workstations
• Certain activities are not allowed on Client workstations:
Creation of Point of Sale company data
Financial Exchange with QuickBooks
Store Exchange with other stores (in a Pro Multi-Store installation)
Connecting to Intuit servers online to manage licensing 

Installing Point of Sale

To install on a Client workstation:
1. Close all running programs, except Windows, on the computer that you are 

installing as a Client.
2. Insert the Point of Sale CD into your CD-ROM drive.

The install Wizard will launch automatically (if it doesn’t, browse to the 
SETUP.EXE file on the CD and double-click it to start the installation).

3. Follow the on-screen prompts to install the program files to the Client 
workstation:
• Install Microsoft .NET Framework 1.1, SP 1, if prompted
• Enter License and Product numbers

The unique numbers from the Point of Sale CD purchased for the 
workstation, or the same numbers used at the Server Workstation*

• Read and accept the license agreement.
• Select CLIENT as the installation type. 

If you mistakenly choose SERVER as the installation type, you will have 
to un-install and reinstall as a Client. Only one Server Workstation is 
allowed on a network.

• Accept the default installation folder (recommended) or browse and enter an 
alternate folder name on this workstation. Do not browse to the server’s 
installation folder over the network! 

4. Follow the prompts to complete the installation.
* With this option, the client will only be able to run Point of Sale at the same time as 
the Server Workstation if you have purchased multiple user licenses.

  IMPORTANT: Install on Only One Client Workstation at a Time!

During installation, Point of Sale must be able to determine the other workstations installed 
and allow you to assign available workstation numbers. If more than one installation is 
running simultaneously on a network, both installing computers may assign the same 
workstation number. This could cause data conflicts and require reinstallation to correct.
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Connecting to the Company Data
Connecting to the Company Data
To connect to the company data on the Server Workstation:
1. Ensure that the Server Workstation is turned on. (Point of Sale does not have to be 

running).
2. Launch Point of Sale on the Client computer.

The Database Connection Wizard searches your network and locates the server 
installation of your company data.
If more than one Point of Sale company data file exists on the network, the 
connection wizard displays a listing of the files. Select the file you wish to access 
and select OPEN SELECTED.

3. Select a workstation number for this computer when prompted, and select OK.
On subsequent launches of this Client workstation, Point of Sale automatically 
reconnects to the same server/company data. 

Connecting and Configuring Hardware
Following the instructions provided with the hardware, connect it now, install drivers, 
and configure Point of Sale. If your hardware doesn’t include instructions for 
configuring Point of Sale to work with it, select SETUP INTERVIEW from the File menu, 
then select the PRINTERS & EQUIPMENT page. Select the SETUP button for each piece of 
hardware you have connected and follow the on-screen prompts.

   Problems Connecting to the Company Data 

Under certain circumstances, such as when the Server Workstation is not turned on or when 
a firewall is enabled on the system, Point of Sale may not be able to automatically detect 
your company data file on the network. If this occurs, the Database Connection wizard will 
launch to assist you in identifying the problem and resolving it. If the issue is related to a 
firewall blocking access, review Appendix B Configuring Firewalls (page 85) for more 
information. 

   Installing Several Workstations? 

If you are installing several workstations with unique license numbers and they don’t have 
an Internet connection, it is recommended that you install them all to the point just before 
connecting to the company data before beginning the license merging process (see below). 
You can register, merge, and synchronize all of the workstations in a single phone call. 
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Chapter 3:  Install Client Workstations
Merging Licenses
If you entered an unique license number for the Client (different than the Server’s), 
you must merge licenses within 30 days or Point of Sale will cease to function on the 
Client Workstation.

To merge licenses:
1. From the prompt displayed, select MERGE NOW.

• If you are connected to the Internet, the merge happens automatically online. 
Select FINISH when the process is completed to close the merge window.

• If you are not connected to the Internet call the phone number shown.
2. Follow the on-screen or phone agent instructions to complete the merge on the 

Client Workstation.
3. To complete the merge and make the additional user license available, the Server 

Workstation must synchronize its license with Intuit's licensing servers.
• If the Server Workstation is connected to the Internet and has previously 

registered, this is immediate and automatic.
• If the Server Workstation is not connected to the Internet or has not yet 

registered, a prompt to synchronize and/or register will be displayed 
periodically until completed. 

To manually synchronize licenses from the Server Workstation:
1. Connect to the Internet on the Server Workstation.
2. From the Help menu, select MANAGE MY LICENSE. 
3. Select SYNC LICENSE DATA ONLINE NOW and follow the prompts.
Alternatively, the synchronization can be done by phone. Select ADD A USER LICENSE 
from the MANAGE MY LICENSE options and follow the on-screen prompts.

Exceeding the Number of User Licenses
If more workstations try to access the Point of Sale company data than you have user 
licenses, a warning dialog is displayed. Your options in this case are: 

• Close Point of Sale on another workstation, so a user license is made 
available to you

• Synchronize licensing with Intuit, if you have just installed and merged a 
new license but have not synchronized yet as explained above

• Buy additional user licenses so additional workstations can connect and use 
Point of Sale at the same time
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Chapter 4 Essential Startup Tasks
Before beginning this chapter, you should have:
Installed and configured your QuickBooks company file according to the 
instructions in  Chapter 6 Integrate with QuickBooks (page 55)
Installed Point of Sale on the Server (and Client, if applicable) Workstations and 
set up Point of Sale according to the instructions in Chapter 2 Install the 
Server Workstation (page 15)

In this chapter, you will:
• Complete the setup of features important to your business
• Import or enter data: items, vendors, customers
• Learn how to complete typical daily tasks

Completing Your Point of Sale Setup
When you completed the Setup Interview, you configured many basic program 
options. Point of Sale offers several other advanced options.Review the following 
topics to see which of these additional setup options might benefit your business.

Setting Up Merchandise Departments
Categorizing your merchandise into departments helps you monitor past performance, 
run meaningful reports, and make future buying decisions. Every item added to 
inventory must be assigned to a department. 

The best number of departments for your store(s)) will depend on how you evaluate 
the performance of your merchandise and how you plan your purchasing. 

  Not all Features and Options Discussed

This chapter is intended to help you get started using Point of Sale in the most efficient 
manner. It does not cover all of the features and options available in Point of Sale. Consult 
the User Guide and the in-program help for information regarding advanced features not 
discussed in this Guide. 
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Chapter 4:  Essential Startup Tasks
If you want to be able to compare the 
performance of two groups of items, 
each group should be assigned its own 
department. For example, if you budget 
X number of purchasing dollars for 
golf shoes and Y number of purchasing 
dollars for running shoes, you should 
assign separate departments for each of 
those shoe types.

By designing your departments carefully, you gain great flexibility when selecting 
and summarizing data for reports. 

Tips for Defining Departments
• Select NEW DEPARTMENT or DEPARTMENT LIST from the Inventory menu to 

create or review your departments. 
• If you elected during the Setup Interview to let Point of Sale add 

departments typical for your business type, you should review those and 
make any changes or additions, to better fit your needs.

• Define a default department tax code if you want all new items added in a 
department to be taxed in the same way.

• If you would like Point of Sale to calculate new item prices for you based on 
either a margin or markup percentage from your cost, specify a value for one 
of those fields in your department records. Point of Sale applies the price 
calculation only to new items and never overwrites prices you have 
manually entered in inventory.

• Press <F1> on the Department window for more information.

Setting Up Markdown Price Levels
Point of Sale can maintain up to five separate prices for each of your items; a regular 
sales price, and four markdown price levels, which are calculated from your regular 
sales price. 

Having multiple price levels allows you to offer different prices to different groups of 
customers automatically, e.g. employees, VIP customers, wholesale customers, 
family members, etc. or for other purposes, such as for promotional sales.

If you entered a margin or markup on your department records, Point of Sale can 
automatically calculate your regular sales price for new items as they are added to 
inventory, based on the department they belong to. If you define markdown price 
levels, they are calculated from your regular sales price.
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Completing Your Point of Sale Setup
A typical price level setup and an example of an item's prices in inventory might look 
like this:

To define markdown price levels:
1. Select EDIT PRICE LEVELS on the Pricing window while working with an item in 

inventory.

Or
From the Edit menu, select PREFERENCES  COMPANY and then select the PRICE 
LEVELS page.

2. Enter a name and markdown percentage for each level you want to use.

Tips for using Price Levels
• The use of markdown price levels is optional
• The price level markdown percentages you specify apply to all items, even if 

you specify them while editing an individual item record
• Point of Sale recalculates the prices at each markdown level anytime your   

regular sales price is changed to maintain your specified markdown 
percentages 

• You can associate a price level to a customer, so that the correct price is 
automatically charged on sales to that customer

• Press <F1> on the item Pricing window for more information
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Setting Up Advanced Sales Tax Options
In the Setup Interview, you had the opportunity to enter a single sales tax rate and the 
agency to which those taxes are paid. Point of Sale used this information to create one 
sales tax location called Local Sales Tax, with two tax codes, Tax (to collect tax on 
taxable merchandise at the rate you specified) and Non (for non-taxable 
merchandise). 

If you need to collect sales tax in different ways, you can set up other sales tax options 
as described here.

Point of sale offers the following sales tax options: 

• Use tax codes to collect taxes based on what merchandise is being sold
• Use tax locations, to collect sales tax based on where the sale takes place
• Collect tax based on defined item price thresholds
• Collect tax on shipping charges
• Associate a sales tax location or tax-exempt status with a customer so that 

sales tax is automatically collected or not collected on sales to that customer
• Specify a default tax location to be suggested for all sales in your store, with 

the ability to change sales tax locations or codes on individual sales
• Map collected sales tax to QuickBooks sales tax items or groups

To set up advanced sales tax options:
1. From the Edit menu, select PREFERENCES  COMPANY and then select the SALES 

TAX page from the left-side menu.

2. Select ADD, EDIT, or REMOVE TAX CODE or TAX LOCATION, as necessary.
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3. Enter the sales tax rate, agency, and define other options as applicable.
Press <F1> on the dialogs displayed for specific instructions.

4. Specify the default sales tax location to use on sales.
5. Select SAVE.

Setting General Sales Receipt Options
You can specify the following sales receipt options:

• Customer payment options available
• Default payment type that is suggested for all new sales
• Payment types that open the cash drawer (if installed)
• Credit card types accepted 
• Require that a customer be listed on sales receipts

To set sales payment options, from the Edit menu, select PREFERENCES  COMPANY 
and then select the SALES page from the left-side menu. Specify the options you 
desire.

Additional options exist when using the QuickBooks POS Merchant or Gift Card 
services.

Configuring Merchant & Gift Services
If you applied for an account with the QuickBooks POS Merchant and/or Gift Card 
Services and have received your account number(s), see Appendix A Merchant & 
Gift Card Services (page 79) for instructions on configuring these services in Point 
of Sale.

Implementing Security and Employee Tracking
 It is strongly recommended that you assign user names and passwords to employees 
and require them to log in to use Point of Sale. You can assign each employee to one 
of the four predefined security groups or create your own custom groups, so that you 
have complete control over the features and data each of your employees can access. 

To require logins, add employees, and assign security rights:
1. From the Edit menu, select PREFERENCES  COMPANY.
2. Select the General page from the left-side preferences menu. 
3. Select the check-box for the REQUIRE USERS TO SIGN IN option and then SAVE.
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4. From the File menu, select 
LOGIN/OUT.

5. Choose Sysadmin as the 
user and leave the 
password field blank, then 
select LOGIN. From the Edit 
menu, select PREFERENCES 

 EMPLOYEES & SECURITY.
6. Choose the Sysadmin user and select EDIT. Assign a password and write it down in 

a safe place. Use this user and password to login anytime you need to change 
security settings or add/delete employees.

7. Select NEW to add an employee. Enter employee information and a password, and 
then assign the employee to a security group.
You can view the access rights of each group by selecting SWITCH TO GROUPS from 
the task list and then highlighting a group name.

8. Select SAVE.
9. Repeat Steps 1 -3 for each employee then close all open windows.

Tips for using Security
• Only the Sysadmin user can add or delete employees, and assign passwords.
• If the predefined security groups don’t meed your needs, you can create 

custom groups with rights of your choosing.
• Press <F1> on the Employees & Security window for more information.

Other Customization Options
Point of Sale offers several other ways to customize the program to better suit your 
business. For more information on these customization features, read Chapter 15 in 
the Point of Sale User’s Guide.

Importing or Entering Data
There is no way to avoid the chore of entering your inventory items, vendors, and 
customers when just getting started. However, Point of Sale does supply some tools 
and a lot of assistance to help complete this task.

• You can import existing data from your QuickBooks company file
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• You can use the Data Import Wizard to bring in data via an Excel 
spreadsheet or as a comma delimited text file (saved as *.csv)

• You can manually enter data
Importing data saves you time and helps avoid errors that can occur with manual 
entry. This section explains all three options for entering your data.

Importing Data from QuickBooks
If you have an existing QuickBooks company file with vendors, customers, and 
items, you can import that data directly into Point of Sale.

Importing Vendors and Customers
Existing, active QuickBooks vendors and customers are automatically imported when 
you complete your first Financial Exchange and routinely shared thereafter. You 
should simply review the imported records and edit them, as necessary, if you want to 
take advantage of additional related Point of Sale features. Refer to Chapter 14 in the 
Point of Sale User’s Guide for tips on editing your imported vendors and customers.

Importing Items
Importing existing QuickBooks items is optional. You can import all QuickBooks 
items or just selected items. After this import, items are not routinely exchanged 
between the programs.

You will be prompted to import each time you go to your Point of Sale item list until 
you complete the import or indicate that you do not plan to import. Choose ASK ME 
AGAIN LATER on this dialog if you plan to import, but are not ready to do at this time.
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You can also initiate an item import by selecting  IMPORT QUICKBOOKS ITEMS from the 
Financial menu or from the Advanced Options page of the Financial Center.

The rest of this section discusses the benefits and procedure of importing items and 
points out some circumstances in which you might not want to import.

Benefits Of Importing Items From QuickBooks
You are not required to import your QuickBooks items, but it is recommended that 
you do so. 

• Importing saves you time and eliminates data-entry errors
• The imported items are immediately available to order, receive, and sell in 

Point of Sale
• Tracking the items in both programs might result in erroneous inventory 

values. Upon importing the on-hand quantities in QuickBooks are 
automatically “zeroed-out” to prevent this.

Most users will want to import all items. However, there may be good reasons to not 
import all items. 

• You have store supply items, such as shopping bags or cleaning supplies, 
that you do not resell. You need these items in QuickBooks to accurately 
track of supply costs, but there is no need for the items to be in Point of Sale. 
You could choose not to import these items, and continue to track them in 
QuickBooks Financial Software. 

• You have a large number of outdated items, which you no longer use in 
QuickBooks. Rather than delete such items or make them inactive in the 
financial software, you may prefer simply not to import them. This way, you 
still have an active record of these items in QuickBooks in case you need 
them in the future.
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What If I Choose Not to Import Items From QuickBooks?
If you choose not to import, you will need to manually add your existing items in 
Point of Sale if you want to order, receive, and sell them in Point of Sale.

To import your QuickBooks items:
1. Select to import when prompted to or select IMPORT QUICKBOOKS ITEMS from the 

Financial menu.
2. In the Item Fields window displayed, read the information presented and specify 

how you want the item information from your QuickBooks items transferred to 
the Point of Sale item description field.

3. On the Item Selection window, answer YES if you want to import only selected 
items or NO to import all QuickBooks items, then select IPORT NOW.

4. If importing only selected items, use the Select Items to Import page to specify 
which of your QuickBooks items should be imported and then select OK.
If the check-box to the left of an item is checked, that item will be imported. Clear 
the check-box if you do not want to import an item. Using the SELECT ALL, 
UNSELECT ALL, and FILTERED VIEW options at the bottom of the page can help you 
locate and make item selections quickly. Select HELP on this page for assistance, if 
necessary. 

  Maintaining a Separate Inventory in QuickBooks Financial Software

If you “divide” your inventory, meaning you track certain items in QuickBooks and others in 
Point of Sale, you should only conduct activities related to those items in the program you 
are using to track them. For example, if you track cleaning supplies in your financial 
software, then you should create all purchase orders, receiving vouchers, and/or sales 
receipts for cleaning supplies in your financial software, not in Point of Sale. 

   Reviewing Your Imported Items

Imported items should be reviewed, and edited as necessary, to take advantage of Point of 
Sale features not offered in QuickBooks. Read and follow the suggestions in the Reviewing 
Imported Data section of Chapter 14 in the Point of Sale User’s Guide. 

  Important: Financial Software Quantities Set to Zero for Imported Items

When you import items, the on-hand quantity for all imported items is set to zero in 
QuickBooks. A compensating General Journal transaction is created to debit the Inventory 
Asset account. The quantities for these items are now tracked in Point of Sale. One or more 
adjustment memos are created in Point of Sale to record the addition of these quantities to 
inventory, thus maintaining a correct inventory valuation.
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Using the Data Import Wizard
The Data Import Wizard is designed to spare you from the time-consuming task of 
manually entering large amounts of existing non-QuickBooks data into Point of Sale, 
such as inventory, customers and vendors. This tool is particularly useful for:

• Importing data you have exported from another point-of-sale software
• Importing data provided by vendors, such as catalog information for new 

items or updates for existing inventory items
You can import data from the default Excel spreadsheet template provided with Point 
of Sale, or one generated by another program or vendor, or from a comma-delimited 
text file (file extension must be .csv).

You have complete control over how information from any of the above sources are 
mapped to the data fields in Point of Sale.

To use the Data Import Wizard:
It is recommended that you backup your company data file before importing.

1. Select UTILITIES  IMPORT from the File menu. The Data Import Wizard launches.
• Specify whether you wish to use the default Point of Sale template or your 

own import file. You can import items, customers, and/or vendors with 
either option. 

• If you are using the default template, enter (or copy and paste) the data to be 
imported in the appropriate columns of the worksheet.

• If you are using your own file, browse to the file and then follow the on-
screen prompts to specify how the data is to be mapped to Point of Sale 
fields.

• Specify other import options, as available for each data type.
2. Start the import process.
Specific instructions are contained on the default import template, or can be accessed 
by selecting HELP or pressing <F1> from within the wizard.

  Warning: Not Importing Items, Then Manually Adding Them in Point of Sale

If you have existing items in QuickBooks, choose not to import them and then manually add 
those same items and quantities to Point of Sale, your financial software inventory value 
can be erroneously increased. This is because when you manually add items and quantities 
in Point of Sale, the program will send inventory adjustments (as General Journal 
transactions) showing increases in inventory value. In this case, you will need to make a 
compensating one-time adjustment in QuickBooks Financial Software to correct your 
inventory value. Refer to the instructions in your QuickBooks Financial Software 
documentation for more information about adjusting inventory amounts.
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Manually Entering Vendors
Each vendor from whom you purchase inventory should be set up in Point of Sale. As 
you add items, you can associate them with a vendor, allowing Point of Sale to track 
your merchandise by vendor as it is ordered, received, and sold.

Creating vendor records allows you to create purchase orders, receive merchandise 
from the vendor, assign payment terms, and filter your item list and reports by vendor 
to analyze sales.

Tips for entering your vendors:
• Select NEW VENDOR or VENDOR LIST from the Purchasing menu to add or 

review your vendors
• Go through the fields on the form, entering information as appropriate:

Company name is a required field
Enter the vendor’s account number and payment terms and they will be 
automatically carried to purchase orders and receiving vouchers you 
create for the vendor
Enter the vendor’s e-mail address or Website address and you can send e-
mails or visit their Website with one click (Internet connection required)

• As you receive merchandise from a vendor, you are building a receiving 
history, which can be viewed on the History tab

• If you imported vendors from QuickBooks, you should review and edit those 
vendor records, as necessary, following the guidelines in Chapter 14 of the 
Point of Sale User’s Guide
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Manually Entering Items 
Inventory items are defined by the combination of item type, department, description, 
and size/attribute values you assign.

Each inventory item must be unique, i.e., there must not be two or more items in 
inventory with the same combination of these values. Also recorded in inventory is an 
item’s cost and price(s), tax code, reorder point, UPC, and other identifying 
information. 

Tips for entering items:
• Select NEW ITEM or ITEM LIST from the Inventory menu to review or add your 

items.
• An entry in the Dept Name and Description 1 field is required for all items.

Tip: You can define a new department on the fly while adding an item by 
selecting NEW from the drop-down list in the department field.

• Go through the item form, including the tabbed pages for additional 
information, entering information in the item fields as appropriate.

When entering existing items, complete all applicable fields, including 
on-hand quantity, average unit cost, and prices.
When entering new items (not already physically in your store), leave the 
On-Hand Quantity field blank and use a receiving voucher to update 
the quantity when the item is received from your vendor. 
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Select the PRICING button to enter cost and prices for the new item 
(optional). Receiving vouchers will always update an item’s average unit 
cost, and if not entered, Point of Sale will calculate your regular sales 
price for you, based on cost plus either margin or markup (as defined in 
the department file) 

• If you collect sales tax, enter the tax code, as appropriate, so that the proper 
tax is collected on sales of the item.

• The Description 1, Description 2, Size, and Attribute fields can be 
renamed to better fit your type of merchandise. Refer to Chapter 15 in the 
Point of Sale User’s Guide.

• Press <F1> on any page for additional help.

Manually Entering Customers
Adding customer records gives you the ability to record those customers on sales 
receipts, thus building a history of customer purchases, which can be valuable in 
providing outstanding customer service and in creating effective marketing 
campaigns. 

Tracking customers also gives you the added benefits of being able to offer store 
charge accounts (also requires use of QuickBooks, and associating pre-defined 
discounts or tax status to your best customers.

When making sales, critical customer information is displayed right on the sales 
document, providing an opportunity for you to see the customer’s status at a glance.
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Tips for adding customers:
• Select NEW CUSTOMER or CUSTOMER LIST from the Point of Sale menu to 

review or add your customers. New customers can also be added while 
making a sale, by selecting ADD NEW from the drop-down list in the 
Customer field on a receipt. 

• Move through the fields on the customer form, including tabbed pages for 
additional information, making entries as appropriate:

The customer’s last name is a required field
Assign a tax location or tax-exempt status, a discount or price level, and 
whether the customer information should be shared with QuickBooks
You cannot make entries in the Account Limit and Account Balance 
fields; this information comes from QuickBooks if used
Indicate whether checks should be accepted from this customer
(Pro) Enter shipping addresses if different than the billing address 

• If you imported customers from your QuickBooks Financial Software, you 
should review those customer records as outlined in Chapter 14 of the Point 
of Sale User’s Guide.

• As you make sales to a customer you are building a sales history, which can 
be viewed on the History tab.

Completing Routine Tasks
This section is a brief introduction to the essential tasks you will typically perform on 
a daily basis.

• Receiving merchandise
• Printing price tags
• Making a sale 
• Handling returns from customers
• Running the End of Day procedure

Receiving Merchandise
A Receiving Voucher is an important Point of Sale document that records the receipt 
of merchandise from your vendors. Saving a voucher adds the received item 
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quantities to inventory and updates the average item cost. These two fields are critical 
in tracking the value of your inventory. 

If you have not already defined your item prices in inventory, a receiving voucher also 
results in your item prices being calculated (assuming you have defined a margin or 
markup for the item). 

To receive merchandise on a voucher:
1. Select NEW RECEIVING VOUCHER from the purchasing menu.
2. If the item(s) being received were ordered on a Point of Sale purchase order (PO), 

enter the purchase order number in the PO # field and press <ENTER>. 
• You are prompted to bring PO items to the voucher. Select ALL DUE to bring 

all due items from the PO or choose SELECT ITEMS to manually select the PO 
items to list. If manually selecting items, enter the received quantity in the 
Doc Qty column of the Select Items window and then select CONTINUE. 

Or
If the items were not ordered on a purchase order: 
• Enter the Vendor from whom the merchandise is being received.
• Scan or type the item’s UPC, Alternate Lookup, or Item # and press 

<ENTER> to list the received item on the voucher. 
3. Select EDIT ITEM (or press <F5>) to review or enter the order cost and received 

quantity.
4. Repeat to list all received items.
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5. If known, enter any applicable freight, fees, or discounts that apply to the 
shipment.

6. Select PRINT TAGS from the task list if you want to print tags for the received items 
at this time. 
Note: Item prices must already be defined in inventory to print tags from a 
voucher. If you are receiving items at a cost higher than what is recorded in 
inventory, you are alerted so that you have the opportunity to review your prices in 
inventory before printing new tags. See additional tag printing instructions below. 

7. Select SAVE & PRINT or SAVE ONLY.
Press <F1> on the receiving voucher for more information.

Printing Tags for Your Inventory Items
Price tags can be printed from inventory, or from receiving vouchers and purchase 
orders using either an inkjet or laser printer with sheet labels, or a compatible tag 
printer such as the Zebra LP2824. 

The printer you use and the tag template specified determine what your tags will look 
like. If your tag design includes a bar code, the program creates the bar code from the 
inventory item number. The reference price (MSRP) prints only if defined for the 
item in inventory.

To print tags:
1. To print tags for one item, highlight the item in inventory or on a document.
2. Select PRINT TAGS from the task list.
3. Make selections in the Print Tags dialog. 

• Specify the printer to be used if it is not already selected
• Specify to print tags for the selected item or for all listed items 

  Vendor Billing Information on Vouchers

If you use QuickBooks Financial Software, you have an option to enter vendor billing 
information on vouchers in Point of Sale, which affects how receiving vouchers are sent to 
QuickBooks. Refer to Chapter 14 in the User’s Guide for a full explanation of this option. 
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• Specify a print quantity: the document or on-hand quantity or a specified 
number

4. Select PRINT or PREVIEW.
5. Select a template in the Select Tag dialog (suggested as your workstation 

preference template choice) and then select OK.
6. (If using sheet labels) Specify a starting location on the sheet of labels and then 

select CONTINUE.
Press <F1> from the Print Tags dialog for more information.

Making a Sale
Sales are recorded on sales receipts and customer returns are typically recorded on 
return receipts. Both types of receipts function in the same way.

To make a sale:
1. Select NEW SALES RECEIPT from the Point of Sale menu.

2. In the Enter Item(s) field, list an item to be sold by scanning or typing the item's 
UPC, Alternate Lookup, Item #, or a search keyword. 
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• If an exact match is found, it is immediately listed on the receipt.
• If no exact match is found, the item drop-down list is displayed with the 

closest match highlighted. If you press <ENTER>, the Find Item window is 
displayed. Select an item or refine your search from these lists.

• Select ADD NEW from the drop-down list to add an item on the fly and 
immediately sell it.

3. Select EDIT ITEM (<F5>) if you need to make changes to the item's quantity, price, 
tax code, or to give item discounts. Select OK (<ENTER>) when done to close the 
edit window and return to the receipt. 

4. Repeat listing and editing items in this manner until all items being sold are listed. 
5. (Optional) In the Customer field, begin typing customer identifying information 

(last name is the recommended entry). 
• If you type last name, Point of Sale displays a drop-down list of your 

customers with the closest match highlighted. Press <ENTER> to accept the 
highlighted name or scroll to another name. 

• Or enter other customer information (first name, company name, phone, 
etc.) and press <ENTER>. If one unique match is found, the customer is listed. 
If multiple matches are found, the Find Customer window is displayed, from 
which you can select the correct customer or refine your search.

Tip: Select ADD NEW from the drop-down customer list or the Find Customer 
window to add a customer record on the fly.

6. Select TAKE PAYMENT to go to the receipt payment screen.

7. Enter amounts for payments the customer gives you in the Amount Tendered 
column and any change you are giving the customer in the Change Amount 
column, until the receipt payment is balanced.
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• The full payment amount is suggested as Cash (or your default payment 
method, if different) and highlighted. To accept this entry press <ENTER>.

• To move the full amount to another payment method, press the up/down 
arrow keys on your keyboard or click in the appropriate cell, and then press 
<ENTER>.

• To enter a different payment amount, simply type over the amount 
highlighted and press <ENTER>.

• Complete any additional information requested, such as check number or 
swiping the customers credit, debit, or gift card.

• If the payment amount exceeds the amount due, the difference is 
automatically suggested as change. Use the same methods to move and 
accept the change amount of the appropriate type.

8.  When the “Payment Complete” message is displayed, select SAVE & PRINT.

Making a Return Receipt
Return receipts are created in the same manner as sales receipts. Select CHANGE TO 
RETURN RECEIPT from the task list before entering information. 

• Enter return quantities as positive numbers.
• Enter the amount being refunded the customer in the Change Amount 

column on the payment screen. 
• You can quickly create a return receipt by locating and copying the original 

sales receipt in your sales history, then changing it to a return receipt. 
Tip: If the customer has their original 
receipt, you can find it quickly in Point of 
Sale by scanning the receipt bar code or 
typing the receipt number in the Quick Find 
field located in the Retail Navigator.

  Handling Exchanges on a Single Receipt

If you need to accept a return and are also making a sale of a replacement item, you can do 
both on a single sales receipt. Simply enter the quantity of the returned item as a negative
number on the sales receipt and the sold quantity as a positive number. Accept payment or 
give change for the net difference in the same manner as described above.
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Running the End-of-Day Procedure
Point of Sale makes closing your store easy with an automated End of Day 
procedure.This procedure can include:

• Running an End of Day X/Z-Out Report
• Optionally requiring the cash drawer to be manually counted
• Settling the day’s credit card batch with the QuickBooks POS Merchant 

Service
• Financial Exchange with QuickBooks
• Backing up your company data
• Sending a Store Exchange file to other stores (Pro Multi-Store only)

To run End of Day:
1. Select END OF DAY from the Point of Sale menu.

2. Select the options you want to run.
3. Follow the on-screen prompts to enter any required information, such as a cash 

drawer count.
Read Chapter 10 in the Point of Sale User’s Guide for more information.
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What’s New in Point of Sale 5.0? 
The Point of Sale team is very excited to bring you the many new features and 
enhancements in this version of Point of Sale, such as:

• QuickBooks POS Gift Card Service—Sell, redeem, and track balances of 
stored-value gift cards from within Point of Sale (optional, fee-based 
service). 

• Item History—Displays a running tally of all quantity changes to an item.
• Advanced Sales Tax Options—Allows you to meet local taxing regulations 

with price-dependent taxing, tax collection on shipping amounts, and an 
unlimited number of tax codes.

• Customize Point of Sale—to work best for you:
Add, remove, and rearrange list columns
Change item description field labels to better reflect your merchandise 
type
Remove unused feature screens, fields, and icons from the program
(Pro) Use Custom fields to record, filter, report and print additional item, 
customer, vendor and employee information
(Pro) Customize printed documents and price tags

• Enhanced Reports & Graphs—Feature sortable columns, QuickZoom 
drill-downs to view additional detail and documents, and a customizable 
Dashboard provides a quick summary of how your business is doing.

• Initiate Transactions from Item List—Open the appropriate document to 
record the purchase, sale, receipt, or transfer of an item directly from your 
item list. 

• Improved Financial Exchange with QuickBooks—Simplified setup, more 
intuitive chart of accounts, more customization choices, and the ability to 
launch QuickBooks and view a linked transaction from within Point of Sale.

• New Licensing Structure—Networked workstations share a single license, 
allowing up to ten simultaneous users. Point of Sale can be installed on any 
number of workstations; with the number of simultaneous users controlled 
by the number of user licenses purchased.

• USB Black Hardware—Point of Sale hardware, available as a bundle or a 
la carte, is now available directly from Intuit in black with USB connections.

• …and much more!
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Learn More about Point of Sale 5.0 Features
• Select WHAT’S NEW from the Help menu after installing
• Search the in-program help index by keyword(s) related to a feature or press 

<F1> from any program screen
• Refer to the related chapters in the Point of Sale User’s Guide
• Select LEARNING CENTER from the Help menu or PRACTICE QBPOS from the 

File menu to watch inter-active Show Me videos or try out Point of Sale 5.0 
with a sample company data file

Let us Know What You Think!
Many of the changes to Point of Sale 5.0 are a direct result of feedback from users 
like you. We encourage you to keep telling us how we can make Point of Sale even 
better! 

To report a problem, make a suggestion, or just comment on how Point of Sale works, 
select SEND FEEDBACK from the Help menu.

Preparing to Upgrade
• Review Chapter 1 Essential Preparation (page 1) to learn about new 

minimum system requirements, the Server/Client database structure, and 
licensing changes for Point of Sale 5.0. 

• Complete activities in your previous version
Settle all unsettled credit card transactions
Conduct a Financial Exchange with QuickBooks
Multi-store users, conduct Store Exchanges so data is uniform among 
stores
Make a backup of your Point of Sale company data

• If you require password logins to use Point of Sale, make sure you have a 
password assigned for the Sysadmin user and that you can access the 
Employees and Security area using this user name. Once you have upgraded 
to Point of Sale 5.0, only the Sysadmin user is allowed to add or delete 
employees, change other employee’s passwords, or turn on/off the login 
requirement. 
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• Do not un-install your previous version before upgrading.
If you have uninstalled, you must either reinstall or insert the CD from 
your previous version when prompted.
To install to a new computer, you must insert the CD from your previous 
version.

• If making changes in your configuration in conjunction with upgrading, such 
as going from one workstation to multiple workstations, adding additional 
stores, or just starting to use QuickBooks Financial Software, read and 
follow the instructions in the chapters of this guide related to those changes.

  Previous Version Remains Intact

The installation of Point of Sale 5.0 does not overwrite previous versions of the software and 
your existing data will remain intact. You can return to the previous version later if you wish, 
but all transactions that you have entered in Point of Sale 5.0 will need to be re-entered in 
the previous version if you choose to do so.

  Same Version/Level Required on all Networked Workstations

All networked workstations must have the same version (5.0) and level (Basic, Pro, or Pro 
Multi-Store) of the Point of Sale software. Once your company data on the Server 
Workstation is converted to work with Point of Sale 5.0, workstations with an older version 
will no longer be able to access it. We recommend you upgrade the Server Workstation first 
(Workstation 1 if upgrading from Version 3.x or earlier), and then upgrade any additional 
Client Workstations.

  Don’t Have CD from Previous Version?

Installing the upgrade requires that your previous version is still installed or that you insert 
the previous-version CD when prompted. If you cannot locate your previous-version CD, 
contact Point of Sale Customer Support at (800) 348-0254. 
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Installing the Upgrade

To upgrade the Server Workstation:
1. Close all running programs, except Windows, on the Server Workstation.
2. Close Point of Sale on all other workstations.
3. Put the Point of Sale Upgrade CD into your CD-ROM drive. (If the installation 

wizard does not launch automatically, browse to the SETUP.EXE file on the CD and 
double-click it to begin the installation). 

4. Follow the on-screen prompts to install the program files to your computer: 
• Point of Sale 5.0 requires that Microsoft .NET Framework 1.1, SP 1 be 

installed. You will be prompted to install this program if necessary. When 
done, you may have to manually restart the Point of Sale installation from  
Step 3.

• Enter the License and Product Numbers provided with your upgrade CD 
• Read and accept the license agreement
• Select SERVER as the installation type 

If you want to specify the installation path and other setup options, select 
CUSTOM as the Installation Type and then select SERVER in the Install Options 
window. Accept the default installation folder (recommended) or browse to 
an alternate location. Note: For best performance install to the local hard 
drive and not to a dedicated network server.

  IMPORTANT: Dedicated Network Server Not Recommended 

We do not recommend using a dedicated network server to hold your Point of Sale 5.0 
company data. Significant performance degradation may result if the company data is not 
on the Server Workstation (where the database applications are).

  Firewalls May Interfere with Point of Sale Activities

Point of Sale 5.0 uses Transmission Control Protocol/Internet Protocol (TCP/IP) for 
communication between workstations and the company data, and for certain activities that 
require communication across the Internet. Firewalls, including the firewall included with 
Windows XP, may block this communication. Typically you will receive a message from your 
firewall indicating it has detected a threat and ask what you want to do about it. Select the 
option to allow access always. This should prevent this message in the future. In the case of 
the Windows XP firewall, Point of Sale will prompt you to allow automatic configuration. We 
strongly recommend that you allow the automatic configuration.

If you continue receiving firewall messages, it may be necessary to manually configure your 
firewall to allow access to the required files and ports. 

Refer to Appendix B Configuring Firewalls (page 85) for additional assistance.
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To convert your previous-version data for use with Point of Sale 5.0:
1. Launch Point of Sale 5.0 on the Server Workstation.
2. If prompted, select a workstation number for this computer.

Point of Sale will detect your earlier version of the program and prompt you to 
copy and convert your data files for use with the new version.
• Select YES to copy and convert your data for use with Point of Sale 5.0 

(recommended) and then continue with the next step.
• Select NO to postpone data conversion until later and view other options, 

including:
Watch an Overview Tutorial 
Use Practice mode to try out the Point of Sale 5.0 features
Create a new company data file (as opposed to converting existing data)
Open an existing Point of Sale 5.0 company data file

If no is selected, the remaining steps in this procedure do not apply.
3. If prompted, enter a unique name for your Point of Sale 5.0 company data file and 

select OK.
Point of Sale copies and converts your data to the Point of Sale 5.0 format. This 
process may take some time, depending on the size of your existing data.
Select OK to close the confirmation window when displayed.

4. If prompted, use your existing user name and password to log in.
5. Register your software when prompted.
6. After registering, select MANAGE MY LICENSE  SYNC LICENSE DATA ONLINE. 

Synchronizing is necessary to update your company data file with the number of 
user licenses you purchased, making them available to Client Workstations. 

To upgrade Client Workstations:

1. Close all running programs, except Windows.
2. Put the Point of Sale Upgrade CD into your CD-ROM drive. (The installation 

wizard does not launch automatically, browse to the SETUP.EXE file on the CD and 
double-click it to begin the installation). 

3. Follow the on-screen prompts to install the program files: 

  IMPORTANT: Upgrade One Client Workstation at a Time!

During installation, Point of Sale must be able to determine the other workstations installed 
and allow you to assign available workstation numbers. If more than one installation is 
running simultaneously on a network, both installing computers may assign the same 
workstation number. This could cause data conflicts and require reinstallation to correct.
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• Enter the License and Product Code Numbers provided with your Upgrade 
CD.This may be the same license numbers you used on the Server 
Workstation.

• Select CLIENT as the installation type 
• Accept the default installation folder (recommended) or browse and enter an 

alternate folder on this workstation. Do not browse to the server's installation 
folder over the network! 

4. Repeat for each additional Client Workstation.

To connect a client workstation to the Point of Sale company data:
1. Ensure that the Server Workstation is running. (Point of Sale does not have to be 

running.)
2. Launch Point of Sale 5.0 on the Client Workstation.

Point of Sale searches your network and connects to the company data on the 
Server Workstation. If more than one Point of Sale company data file exists on the 
network, a window is displayed listing the names of the files. Select the company 
data you wish to access and select OK.

3. If prompted, select a workstation number for this computer and select OK.
4. If prompted, use your user name and password to log in to the program. 

On subsequent launches of Point of Sale, this workstation will automatically 
reconnect to the same server/company data. 

5. Repeat this procedure for each of your client workstations.

Merging Licenses
In Point of Sale 5.0, all workstations on a network share one license. If the license 
numbers you used to install your Client Workstations are different than the license 
number of the Server Workstation, you will be prompted to merge those licenses with 
the license installed on the Server Workstation. 

For instructions on merging licenses, read  Merging Licenses (page 26) or for 
general information about Point of Sale 5.0 licensing, read  Point of Sale Licensing 
(page 9). 

   Problems Connecting to the Point of Sale Company Data 

Under certain circumstances, such as when the Server Workstation is not turned on or when 
a firewall is enabled on the system, Point of Sale may not be able to automatically detect 
your company data file on the network. If this occurs, the Database Connection wizard will 
launch to assist you in identifying the problem and resolving it. If the issue is related to a 
firewall blocking access, review Appendix B Configuring Firewalls (page 85) for more 
information. 
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Important Steps after Upgrading

Settings Returned to Defaults after Upgrade
Due to the implementation of new features, data fields, and screen layouts, certain 
customizations and selections you have made in previous versions, as listed below, 
are reset to default values upon upgrading. 

All other program preferences, user names, passwords, and prior security rights are 
transferred from your previous version to Point of Sale 5.0.

You should review and reconfigure these settings as appropriate for your situation.

• Review and reconfigure list column layouts. Point of Sale 5.0 now allows 
you to add or remove columns to suit your business. Right-click a column 
header and choose CUSTOMIZE COLUMNS.

• Re-enter your memorized report layouts and filter criteria. Reports in Point 
of Sale 5.0 have been re-engineered to support QuickZoom data drill-downs.

• Review and edit custom security groups, if applicable. Employees assigned 
to custom groups will not have access to new features until you update the 
group rights to include those features, as appropriate. From the Edit menu, 
select PREFERENCES  EMPLOYEES AND SECURITY and then select SWITCH TO 
GROUPS on the task list.

• If used previously, reset your QuickBooks Integrated Applications 
preferences to allow automatic login. Instructions can be found in Chapter 
14 of the Point of Sale User’s Guide.

  Discontinue Using Previous Version

Once you have completed the upgrade installation and converted your data for use with 
Point of Sale 5.0, it is recommended that you either un-install the prior version, or remove 
any desktop shortcuts for the prior version, to prevent inadvertently launching the wrong 
Point of Sale application. Using the previous version would make changes to the old 
company data file and these transactions would not be recorded in the 5.0 company data 
file.
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 Apply for a QuickBooks POS Gift Card Account
Processing gift card transactions and tracking card balances within Point of Sale 
requires an account with the QuickBooks POS Gift Card Service, an optional fee-
based service provided by Innovative Merchant Solutions, LLC (IMS), an Intuit 
company. 

You can get additional information and apply online from the Gift Card Service page 
of the Setup Interview (select SETUP INTERVIEW from the File menu) or you can call 
800-926-9066.

Once you have received your account number, refer to Appendix A Merchant & 
Gift Card Services (page 79) for instructions to configure Point of Sale for the 
service.

Reset Store Exchange Settings (Pro Multi-Store)
Store Exchange settings are copied from your previous version, however in order for 
Store Exchange to continue functioning you need to update these settings to reflect 
the new 5.0 file paths and new license numbers for the Server Workstations at each 
store. 

To update Store Exchange settings: 
1. From the Edit menu, select PREFERENCES  COMPANY.
2. Select MULTI-STORE  STORE EXCHANGE from the left-side menu and enter the new 

license numbers, transfer paths, and "In" folders as applicable. 
The "In" folder can be quickly set to the default location by selecting the DEFAULT 
button or you can specify a custom path.

3. Select SAVE.

   Remote Stores Cannot Share Network “In Folder”

If using direct file transfer for Store Exchange, remote stores should not all set their In 
Folder to the same location on a network. When a remote store finishes processing a 
mailbag from Headquarters on a network drive, it deletes the mailbag file. If Headquarters 
were to send a mailbag file to a single network folder, the first remote store to process it 
would then delete the file, leaving no file for the other stores to access. Each remote should 
specify a separate In folder location, and Headquarters should send a separate file to each.
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Before beginning this chapter, you should have:
If on a network, decided which computer to make the Point of Sale Server 
Workstation, based on the information in Chapter 1 Essential Preparation 
(page 1). 

In this chapter, you will:
• Review on overview of how integration works
• Learn the requirements of integration
• Install QuickBooks to exchange information with Point of Sale 
• Create and/or review your QuickBooks company file for integration
• Learn how to use the QuickBooks Connection Wizard to connect the two 

programs 
• Be introduced to Financial Exchange options that you can set up later

Overview
Point of Sale is designed to be integrated with QuickBooks Financial Software. Point 
of Sale tracks your daily point-of-sale business: purchasing, receiving, sales and 
related inventory activities, while QuickBooks Financial Software tracks your 
financial data.

Exchanging information between the two programs, referred to as Financial 
Exchange, can significantly reduce your workload because you can track sales 
activities in Point of Sale, and then transfer the resulting data directly into 
QuickBooks. There’s no need to enter information twice!

Several options are available for you to customize how your Point of Sale data is 
transferred to QuickBooks so that it works for your business model and for how you 
prefer to have your retail activities reported.
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Integration between QuickBooks and QuickBooks Point of Sale is to help you get the 
most benefit from the specialized features of each program. The chart below outlines 
the activities that take place in each program.

You do not have to immediately integrate the two programs upon installing Point of 
Sale. However, if you already have a QuickBooks company file with existing 
customers, vendors, and inventory, you can save a great deal of time by integrating 
from the start and importing those records into Point of Sale.

Important: Only the Point of Sale Server Workstation can conduct Financial 
Exchanges with QuickBooks. In a Pro Multi-Store installation, Financial Exchanges 
are done at Headquarters only, so QuickBooks only needs to be installed at 
Headquarters.

Requirements for Integrating with QuickBooks
The requirements for integration are as follows:

• A supported version of QuickBooks Financial Software: Pro or Premier 
Editions (2003 - 2006) or Enterprise Solutions (2.0 - 6.0)

• If connecting across a network, a properly installed and configured network 
with mapped drives as appropriate for your installation choice (see next 
section)

Activity Point of Sale 
(Retail Activities)

QuickBooks
(Financial Activities)

Add and track inventory items X

Order and receive merchandise X

Ring up sales & collect sales tax X

Run sales & merchandise reports X

Add customers or vendors X X

Track cost of goods and expenses X

Pay bills and sales tax X

Invoice customers X

Process payroll X

Run financial reports X

Banking activities X
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Installing QuickBooks Financial Software
If you are not already using QuickBooks, use the instructions in this section to install 
your financial company file for use with Point of Sale. If you are installing both 
programs at the same time it is strongly recommended that you install and configure 
your QuickBooks company file first.

If you are already using QuickBooks and have your company file set up, review this 
section to ensure your installation location is suitable to exchange data with the Point 
of Sale Server Workstation.

QuickBooks Installation Options
Your QuickBooks Financial Software can be installed in any of three configurations. 
Study these three options and determine the best configuration for your 
circumstances. 

Configuration 1: QuickBooks on the Point of Sale Server 
Workstation
This is the simplest configuration and the only choice if you have only one 
workstation.

On a network, the Server Workstation could be at point-of-sale or in a back office, 
with additional Client Workstations installed on the network as needed.

Point of Sale Server Workstation

Network

Client Workstations (optional)

• Point of Sale and company data
• QuickBooks and company file
• Database applications

• Point of Sale program files
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Configuration 2: QuickBooks Financial Software installed on 
both the Point of Sale Server Workstation and on another 
computer
This common two-workstation setup requires a peer-to-peer network and is possible 
even if you have only a single-user license for your QuickBooks Financial Software.

This configuration enables you to use your QuickBooks Financial Software on a 
different computer, such as in the office, while using Point of Sale at the front register.

For this configuration:

• Install QuickBooks on the other computer (the “Office”) first and set up your 
QuickBooks company file. Then, install a second instance of QuickBooks on 
the Point of Sale Server Workstation (the “Register”). 

• Make sure you have network drives mapped so the two computers can 
communicate with each other.

• Once configured, QuickBooks does not need to be open on the register 
computer but it cannot be un-installed. 

• Additional Point of Sale or QuickBooks installations could be added to the 
network with appropriate licensing.

Point of Sale Server Workstation

• Point of Sale installed
• QuickBooks program installed
• Drive mapped to QuickBooks 

company file on other computer

QuickBooks Computer (Office)

• QuickBooks installed
• QuickBooks program company file
• Company file folder set to “share” access

Network
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Configuration 3: QuickBooks installed only on another 
network computer. 
This configuration, called Remote Data Sharing (RDS), is an alternative way for the 
two programs to exchange information across a network using server and client 
applications and without the need to install QuickBooks on additional computers. The 
RDS Server/Client applications are included on your Point of Sale CD. 

This configuration requires more technical expertise to set up and operate and is not 
discussed in detail in this section. If you would like to know more about this option, 
read Appendix C of this Guide before continuing. 

• QuickBooks is not installed on the Point of Sale Server Workstation
• This configuration is used on a client/server network; no network mapping is 

required
• QuickBooks and the QuickBooks company file must be open and the Server 

application must be running during Financial Exchanges
• Additional Point of Sale or QuickBooks workstations can be added to the 

network with appropriate licensing

Install QuickBooks Financial Software
Follow the instructions provided with your QuickBooks software to install your 
software on a computer to fit the selected configuration from above. 

If you chose Configuration 2, install QuickBooks on the other network computer 
(Office) first. Complete the configuration of your company file as described below. 
When done, follow the procedure later in this chapter to install a second instance of 
QuickBooks on your Point of Sale Server Workstation (Register).

Point of Sale Server Workstation

• Point of Sale installed
• RDS Client application installed

 QuickBooks Computer

• QuickBooks installed
• RDS Server application installed

Network
59



Chapter 6:  Integrate with QuickBooks
Configuring QuickBooks 
If you are new to QuickBooks, the easiest way to configure your QuickBooks 
company file to work with Point of Sale is to use the EasyStep Interview within 
QuickBooks. 

If you already have a QuickBooks company file set up, skip to the section titled  
Reviewing Your QuickBooks Setup (page 62).

Completing the QuickBooks EasyStep Interview
When you start QuickBooks the first time you are prompted to create a new company 
file. Follow the prompts to create the file and then the EasyStep Interview will be 
launched.

As you move through the interview to set up your company file, making selections as 
described below will help configure it to work best with Point of Sale. If a section of 
the interview is not mentioned in the table below, the choice is not critical to 
integration. Make choices for those areas based on your individual situation.

The order and language used in this table comes from QuickBooks 2005 Premier 
Retail Edition; the exact order and language you see may vary slightly with other 
versions of QuickBooks.

   If You Are Using the Premier Retail Edition of QuickBooks

The first choice you have when creating a new QuickBooks company file is to choose a 
predefined company file that is designed for your type of business (retail). We strongly 
recommend that you choose TRACK SALES IN QUICKBOOKS POINT OF SALE. This choice 
will automatically add some of the accounts you need in your QuickBooks Chart of Accounts 
to work well with Point of Sale and will save you time as you complete the rest of the 
QuickBooks setup.

EasyStep Interview Question Recommended Response/Instructions

Does your company maintain 
inventory?

YES

Do you want to turn on the 
inventory feature?

YES

Do you collect sales tax? YES, if you are required to collect taxes on sales  
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Do you have single or multiple tax 
rates?

Answer as appropriate for your situation. If you have 
a fairly simple tax structure with all tax payments 
made to a single agency, your choice here is not 
critical since Point of Sale can automatically create 
tax items and codes for you later if necessary.
If your tax situation is more complicated, requiring 
the use of tax groups in QuickBooks to pay taxes to 
multiple agencies for example, refer to  Is 
QuickBooks configured to collect sales tax?  
(page 64) for more information about configuring 
QuickBooks sales tax.

Do you want to track segments of 
your business using classes?

(Basic and Pro Users) Does not affect integration for 
you. Use at your discretion.
(Pro Multi-Store Users)  YES, if you want to run profit 
& loss reports in QuickBooks by store. You will also 
have to enable class tracking in Point of Sale when 
you configure it later. Once enabled in both 
programs, Point of Sale will automatically create 
classes in QuickBooks for called Store 1, Store 2, 
etc.

Two ways to handle bills and 
payment: Choose one of the 
following ways to track your bills 
and payments

Select ENTER THE BILLS FIRST AND THEN ENTER 
THE PAYMENTS LATER. This enables the use of 
vendor bills, which allows Point of Sale to send 
billing information to QuickBooks as items are 
received from your vendors.

Income and Expense Accounts Point of Sale uses a default chart of accounts to 
transfer income and expense data to QuickBooks. 
You don’t have to add these default accounts; Point 
of Sale will create them as necessary once you are 
exchanging data. 
If you wish to create your own income and expense 
accounts, do so at your discretion. Later, when you 
configure Point of Sale, you can “link” Point of Sale 
data to your custom accounts.

Receipt of Payment: Do you 
receive full payment at the time (or 
before) you sell a product or 
service?

Select SOMETIMES or NEVER. With these choices, 
QuickBooks will create an Accounts Receivable 
account for you (necessary for integration).

Statement Charges: Will you be 
using statement charges?

YES, if  you plan to allow charges to customer 
accounts and send statements to them.

Income Details: Do you want to set 
up items?

If you are going to sell and track an item or service in 
Point of Sale, do not add it in QuickBooks. Point of 
Sale supports all of the same item types available in 
QuickBooks.
If you have items you won’t resell in Point of Sale 
and prefer to track in QuickBooks, such as store 
supplies and shopping bags, you can enter them in 
this section.

Opening Balances: Customers If you have customers that owe you money, add 
them and their account balance as of the starting 
date you selected.

EasyStep Interview Question Recommended Response/Instructions
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Reviewing Your QuickBooks Setup
Both new and existing QuickBooks users should use this section to verify that your 
QuickBooks company file is ready to be connected to Point of Sale and exchange 
data. 

Is inventory turned on?
Inventory features must be enabled in QuickBooks for integration.

To turn on inventory in QuickBooks:
1. From the Edit menu, select PREFERENCES. 
2. Select the PURCHASES & VENDORS area from the left-side preferences menu. 
3. Select the Company Preferences tab.

Opening Balances: Vendors This section won’t directly affect Financial 
Exchanges with Point of Sale, but if you owe money 
to vendors, it is a good idea to enter the balances 
now. When you transfer receiving vouchers from 
Point of Sale to QuickBooks, your vendor balances 
will then be up-to-date. 

Bank Accounts: Would you like to 
set up bank accounts?

Set up at your discretion. Point of Sale will 
automatically create the Cash in Drawer account 
used to transfer Point of Sale information, if it doesn’t 
already exist when you start exchanging data.

Asset Accounts: Would you like to 
set up an asset account?

YES, add the following accounts, which are required 
for integration with Point of Sale. If an account 
already exists, QuickBooks will alert you, and you 
don’t have to add it again.

EasyStep Interview Question Recommended Response/Instructions

Account Name Type

Undeposited Funds Other Current Asset

Inventory Asset Other Current Asset
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4. Make sure the checkbox labeled  INVENTORY AND PURCHASE ORDERS ARE ACTIVE is 
checked. 

5. Select OK.

Are all necessary accounts set up? 
Review your QuickBooks Chart of Accounts (from the Company menu, select CHART 
OF ACCOUNTS) and make sure the accounts in the table below are listed. If you just 
completed the QuickBooks EasyStep Interview all of these accounts, with the 
exception of the Cost of Goods Sold account, should be set up at this point.

If a listed account is not present, add it now using the procedures that follow. 

Note: If you already have accounts of the same types but with custom names in 
QuickBooks, you can temporarily rename those accounts to these defaults, establish 
the connection, and then restore your custom names instead of creating new accounts. 
Once connected, edit your Point of Sale company preferences to point to the custom 
accounts.

To create these accounts in QuickBooks:
• To create Cost of Goods Sold and Inventory Asset accounts: From the item 

list, select NEW ITEM from the Edit menu, select INVENTORY PART in the Item 
Type field, and then cancel

• To create an Undeposited Funds account: Select ENTER SALES RECEIPTS 
from the Customers menu and then close the form

• To create an Accounts Receivable account: Select CREATE INVOICES from the 
Customers menu and then close the form

• To create an Accounts Payable account: Select ENTER BILLS from the 
Vendors menu and then close the form 

• To create a Sales Tax Payable account: From the item list, select NEW ITEM 
from the Edit menu, select SALES TAX ITEM in the Item Type field, and then 
cancel

Account Name Type

Cost of Goods Sold Cost of Goods Sold

Accounts Payable Accounts Payable

Accounts Receivable Accounts Receivable

Undeposited Funds Other Current Asset

Inventory Asset Other Current Asset

Sales Tax Payable (if you collect taxes) Other Current Liability
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Are Integrated Applications preferences set to allow access?
Your QuickBooks Integrated Applications preferences must be set to allow Point of 
Sale to access your company file. The default QuickBooks setting is to allow access, 
so this setting should only have to be changed if you have previously changed it to not 
allow access. 

To make sure QuickBooks allows access to Point of Sale:
1. From the Edit menu, select PREFERENCES.
2. Select the INTEGRATED APPLICATIONS area from the left-side preferences menu.
3. Select the Company Preferences tab.
4. Make sure the checkbox labeled  DON’T ALLOW ANY APPLICATION TO ACCESS THIS 

COMPANY FILE is cleared (not checked).
5. Select OK.

Is QuickBooks configured to collect sales tax? 
If you collect sales tax, check your QuickBooks sales tax preferences to make sure the 
collection of sales tax is turned on.
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To set sales tax preferences in QuickBooks:
1. From the Edit menu, select PREFERENCES.
2. Select SALES TAX area from the left-side preferences menu.
3. Select the Company Preferences tab.
4. If you charge sales tax, make sure the response for Do You Charge Sales Tax? is 

YES.
If you do not charge sales tax, make sure the response for Do You Charge Sales 
Tax? is NO. 

5. Select OK. 
If you pay sales taxes to a single agency, no further tax setup is required in 
QuickBooks. You can set up sales tax rates and other tax options in Point of Sale, and 
when you do a Financial Exchange Point of Sale will create the necessary sales tax 
items and codes in QuickBooks for you. If you already have sales tax items and codes 
set up in QuickBooks, you can link those items and codes to your Point of Sale tax 
setup when you reach that point.

Do you need to set up sales tax groups? 
If you need to pay sales taxes to more than one tax agency, you may want to set up 
sales tax groups in QuickBooks so that your sales tax reports break out the tax 
payments correctly. Once set up in QuickBooks, you can link sales taxes in Point of 
Sale to the QuickBooks tax group(s). Point of Sale cannot automatically create sales 
tax groups for you. 

Consult your QuickBooks documentation or in-program help files for more 
information about using and setting up sales tax groups if this applies to you.

Do your existing QuickBooks lists need to be cleaned up? 
If you've been using QuickBooks for some time, you may have accumulated 
customers, vendors, or items that are no longer needed or used. Cleaning out unused 
items helps streamline Financial Exchange and avoids duplication of unused items.

To remove unused list items:
1. From the Lists menu in QuickBooks, select the list you want to review.
2. Select a specific list item you want to remove.
3. Select ITEM, VENDOR, EMPLOYEE, as applicable, at the bottom of the screen to 

display available options.
4. Select DELETE or MAKE INACTIVE. 
Deleting an item removes it permanently. Making it inactive removes it from the 
normal list view but retains the record so that you can access it again. If the item has 
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been used on QuickBooks documents, deletion may not be possible. Inactive items 
will not be exchanged with Point of Sale.

Have you set up password control to your QuickBooks 
company file? 
It is strongly recommended that you set up user names and passwords to control 
access to your QuickBooks company file.   

With password security in place in QuickBooks, employees running Financial 
Exchanges from Point of Sale cannot view or access your QuickBooks company file, 
even if both programs are installed on the same workstation.

Consult your QuickBooks documentation or in-program help files for more 
information about setting up password control. Later, when you install and configure 
Point of Sale, you can set up password control to features and data there as well.

Installing a Second Instance of QuickBooks on the Point of Sale Server 
Workstation

This section applies only if you chose Configuration 2 for installing QuickBooks. If 
you only have a single workstation or are using RDS, you can skip this procedure. 

You should have already completed the installation and configuration of your 
QuickBooks company file on the other (Office) computer before beginning the 
procedure below, which will install a second instance of QuickBooks on the computer 
that will be the Point of Sale Server Workstation (Register).

To install QuickBooks on the Point of Sale Server Workstation:
1. Be sure that the two computers are properly networked in a peer-to-peer 

configuration. (Refer to your Windows documentation or consult a qualified 
computer technician if you need assistance in mapping network drives or setting a 
folder to share access as required in this procedure.)

2. On the Office computer, set the QuickBooks company file folder to "Share" status.
3. On the Point of Sale Server Workstation, map a drive to the QuickBooks company 

file folder on the Office computer. 
4. Close QuickBooks on the Office computer.
5. Install QuickBooks on the Register computer, using your existing QuickBooks 

CD and instructions. 
This is allowed by a single-user QuickBooks license agreement even though you 
already have QuickBooks installed on your office computer, provided that 
multiple users do not access QuickBooks simultaneously from both computers. 
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6. After installing, launch QuickBooks on the Register computer and log on with 
Administrator rights. Open your QuickBooks company file that is stored on the 
Office computer from the Register (across the network, do not launch QuickBooks 
on the Office computer).

7. Optional: Create a new user in your QuickBooks Financial Software with full 
Administrator rights called "QBPOS User" or similar. 

8. Save your settings and exit QuickBooks.

Connecting to QuickBooks
After installing Point of Sale, you will be able to connect the two programs and begin 
sharing data by using the QuickBooks Connection Wizard from within Point of Sale.

You can access the connection wizard and establish the connection in 
several different ways:

• From the Use with QuickBooks page of the Point of Sale Setup Interview
• From the Financial Center (select FINANCIAL CENTER from the Financial menu 

in Point of Sale)
• Anytime you use a Point of Sale feature that requires a connection, the 

wizard will launch automatically and prompt you to establish a connection
The first time you connect:

• QuickBooks must be running
• You must be signed into QuickBooks as a user with Administrator rights 

(you can use the “QBPOS User” set up above or just sign in as “Admin”
• Your QuickBooks company file must be open

From that point on, Point of Sale will reconnect to the same company file whenever 
needed. During that first connection, you may have the option to allow Point of Sale 
to login automatically in the future even when QuickBooks is not running. It is 
strongly recommended that you allow automatic login. If this option isn’t available on 
first connection, you can set this preference later in QuickBooks.

Congratulations! You have completed preparing your QuickBooks Financial 
Software and it is now ready for integration with Point of Sale!

You may want to take a few minutes to familiarize yourself with the Financial 
Exchange options in the next section. Then you’ll be ready to return to Chapter 2 
Install the Server Workstation (page 15) and continue with your Point of Sale 
installation. 
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Financial Exchange Options
The options below are available after Point of Sale and QuickBooks are connected 
and exchanging data. They are listed here to make you aware of the ways in which 
you can customize Financial Exchange to be most beneficial to your business. 

Importing Existing QuickBooks Data. If you already have a QuickBooks 
company file with existing customers, vendors, and inventory when you start to 
use Point of Sale, that data can be imported to Point of Sale to get you up and 
running more quickly. Refer to Chapter 4 Essential Startup Tasks (page 27) for 
more information on importing QuickBooks data.

Sending Point of Sale Receipts and Vouchers with Detailed Item 
Descriptions. In the default setup, sales and receiving documents are sent to 

QuickBooks in a summarized format. This streamlines Financial Exchange and 
presents data in a concise format. If you prefer, you can send these documents in 
a detailed format. Refer to Chapter 14 in the Point of Sale User’s Guide for 
information about this option. 

Changing the Way Vendor Billing Information is Handled. You can enter 
vendor billing information for merchandise purchases in QuickBooks or on 
receiving vouchers in Point of Sale. This setting controls how the receiving 
vouchers created in Point of Sale become a bill in your QuickBooks Accounts 
Payable account. Refer to Chapter 14 in the Point of Sale User’s Guide for 
information about this option. 

Customizing Account Mappings. If you wish to have Point of Sale data sent to 
accounts other than the default accounts, you can link accounts and payment 
types in Point of Sale to different QuickBooks accounts of your choosing. Refer 
to Chapter 14 in the Point of Sale User’s Guide for information about this option. 

Allowing Automatic Login to QuickBooks. Depending on your specific 
version of QuickBooks and whether you use Remote Data Sharing (RDS), you 
may have the option to exchange data even when QuickBooks is not running. 
Refer to Chapter 14 in the Point of Sale User’s Guide for more information about 
this option. 

Using QuickBooks Classes to Run Reports by Store. (Pro Multi-Store) You 
can run profit/loss (P/L) reports for each store as well as the entire company in 
QuickBooks, by assigning a QuickBooks class to each store. Refer to Chapter 13, 
Managing Multiple Stores, in the Point of Sale User’s Guide for more 
information on this option.
68 QuickBooks Point of Sale



Chapter 7 Configure Multiple Stores
This chapter is intended to give you an overview of a multi-store installation of Point 
of Sale. The actual program installation instructions for multi-stores is the same as 
presented in earlier chapters. However, a knowledge of the information provided here 
is essential for proper installation sequencing and walks you through the additional 
steps necessary to set up communications between stores. We recommend you review 
this chapter thoroughly and plan an implementation strategy, so that you are 
prepared to make decisions during the installation and configuration procedures.

What you will learn in this chapter:
• The differences between a Headquarters Store and remote stores
• The four methods that can be used to exchange information between stores
• The recommended setup sequence and procedures for a multi-store 

configuration
• How to initialize remote stores with data from Headquarters

Multi-Store Overview
With Point of Sale Pro Multi-Store, you can effectively manage up to ten stores with 
features like centralized purchasing, inter-store transfers, sharing of information 
between stores, and company-wide reporting. At a glance an associate at one store 
can view the quantities available at all other stores, thus minimizing lost sales due to 
out-of-stock situations.

In a multi-store configuration, one store is designated as the Headquarters (Store 1). 
Headquarters maintains central control over inventory, purchasing, creates the 
company data file, defines company-wide preferences, exchanges data with 
QuickBooks, and can run reports that include the activities at all stores. The 
Headquarters store also carries out normal store activities, such as receiving 
merchandise and making sales.

Stores 2-10 (called remote stores) receive and sell merchandise, transfer items as 
necessary to other stores, define their own employees and security settings, and run 
local store reports. 

At the end of the business day, each remote store runs its normal End of Day 
procedure, including settling its own credit card transactions. Included in the End of 
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Day process is a Store Exchange procedure by which remotes can send their daily 
point-of-sale information to Headquarters. Headquarters processes the exchange files 
it receives from the remote stores, updates inventory and related records with the 
day's activities, exchanges data with QuickBooks, and then sends updated company 
information back to the remote stores, who process it in before beginning their next 
business day.

The diagram below depicts a typical two-store configuration.

Choosing a Headquarters Store 
The choice of a Headquarters store is important because in addition to performing all 
of the activities of a typical store, only Headquarters can:

• Add, edit, or delete inventory items and related information, such as 
departments and vendors. All stores share one item list.

• Create regular purchase orders.* 
• Consolidate data for the entire company and run company reports. Remote 

stores can run and view local reports only.
• Exchange data with QuickBooks.
• Create documents on behalf of other stores, allowing Headquarters, where 

management and finance personnel are typically located, to correct or adjust 
transactions on behalf of remote stores.

*The exception to this is special order items, which can be created and ordered at 
remote stores. For more information about the roles, allowed activities, and 
limitations at each store type, refer to Chapter 13 in the Point of Sale User's Guide.

Store Exchange
via e-mail, direct file 

transfer, or removable 
media

Store 1 
Headquarters

Store 2 
Remote

Clients

QuickBooks 

Clients

Server Workstation Server Workstation
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Methods of Store Exchange 
The term Store Exchange refers to the transfer of data between Headquarters and 
remote stores. The Store Exchange files are referred to as mailbags. 

There are four communication methods by which Store Exchange mailbags can sent 
between stores. Each remote store exchange with headquarters with the method of its 
choice.

The four communication methods are:

• Desktop e-mail – Your default e-mail program that launches when you 
select to send an e-mail from within a Windows application. 

Examples: Outlook, Outlook Express, Netscape E-Mail

• Web-based e-mail – An e-mail service that you access on the Internet 
through your browser. 

Examples: Yahoo!® Mail, and MSN Hotmail

• Network file transfer – Direct file transfer to or retrieval by other 
computers using mapped drives or UNC (Universal Naming Convention) 
location.

Examples: VPN (Virtual Private Network), WAN (wide-area network), 
or LAN (local area network)

• Removable media – Removable media that is physically transported to 
other stores. 

Examples: Floppy disks, USB memory sticks, Zip drives, CD-RW (read-
write CDs) 

For more information about these methods of Store Exchange, search the in-program 
help index using keyword “Store Exchange” and then choose “Methods” or press 
<F1> from any Store Exchange dialog. 
71



Chapter 7:  Configure Multiple Stores
Multi-Store Setup Sequence
This general setup sequence is typical for a multi-store installation. Additional detail 
for the steps unique to a multi-store installation is provided in the remainder of this 
chapter. 

At Headquarters:

1. Install and/or prepare your QuickBooks Financial Software for data exchange.
2. Install Point of Sale at the Server workstation
3. Create your company data file (choose HEADQUARTERS as the store type)
4. Complete the Setup Interview to configure company and workstation settings.

• On the Other Stores page of the interview, set up your remotes stores and 
specify Store Exchange options.

5. Install Point of Sale on Client Workstations.
6. Set up your Point of Sale departments, sales taxes, price levels, and other options, 

and then import or manually add items, vendors, customers, etcetera, that will be 
shared by all stores.

7. After remote stores have installed, run a Store Exchange Out on the Server 
Workstation to send an initialization file to remote stores.

 At Remote Stores:

1. Install Point of Sale on the Server Workstation.
2. Create a company data file (choose REMOTE STORE as the Location type and 

specify a Store Number).
3. Complete the Setup Interview to configure Store Exchange, store-specific and 

workstation-specific preferences.
4. Install Point of Sale on Client workstations.
5. Run a Store Exchange In on the Server Workstation to receive and process the 

initialization file from Headquarters.

   Significance of the Server Workstation 

The Server Workstation is an important concept in Point of Sale. Important program 
activities, such as creating company data, running Store Exchanges, and obtaining online 
program and license updates from Intuit servers, can only be done from the Server 
Workstation at each store. At Headquarters, this is the only workstation that can run 
Financial Exchanges with QuickBooks. The Server Workstation ideally will be your fastest 
and most powerful computer in each store and must be equipped to handle communications 
with other stores, i.e. with an Internet connection, modem, or supported removable media 
depending on how you exchange data. 
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Configure at Headquarters 

To configure multi-store settings at Headquarters:
1. Follow the procedures outlined in earlier chapters of this Guide to install and 

prepare your QuickBooks Financial Software, install Point of Sale on your Server 
Workstation selecting SERVER WORKSTATION as the Installation Type.

2. Launch Point of Sale and create your company data file, making sure you select 
HEADQUARTERS as the Location.

3. Start the Setup Interview, and use the steps below when you reach the Other Stores 
page.

4. Select ADD STORE.

  Collect Information and Install at Headquarters First

The data and program preferences entered at Headquarters will be used later to initialize 
your remote stores, so that each store does not have to re-enter all the same information. 
You should complete the setup at Headquarters before installing at your remote stores. 
Collect the following information before beginning: 1) the License Numbers for the Point of 
Sale software that will be installed on the Server Workstation at each remote store, and 2) 
the e-mail address, file transfer path (mapped drive or UNC), or removable media type that 
will be used at the Server Workstation at each remote store Store Exchanges.
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The Add Store Wizard opens.

5. Enter a 1-3 character Store Code and a Store Name for your first remote store.
The store code and name are displayed throughout the program and on printed 
documents and reports.

6. Select a communication method for Store Exchanges with this store and select 
NEXT.

7. Enter the License Number from the Server Workstation at the remote store and the 
e-mail address (if using desktop e-mail) or a location to which Store Exchange 
files are copied (any other communication method). 
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The bottom section of this dialog changes if a communication method other than 
desktop e-mail is selected:

Specifying e-mail addresses or file transfer paths:
• If using a desktop e-mail client, enter the e-mail address for the remote store. 

You can click the chevron to the right of the field to access your default e-
mail client’s address book to select this address.

• If using web-based e-mail, specify a folder to which Store Exchange files 
will be copied. To send the mailbag to remote stores in a web-based e-mail, 
you will have to access your web-based e-mail service and follow their 
instructions for browsing to the specified folder and attaching the file.

• If using removable media, enter or browse to the drive or port. For example, 
to your CD-ROM drive or a USB port.

• If using network file transfer, enter or browse to the store exchange "In 
Folder" of the Point of Sale 5.0 installation on the Server Workstation at the 
remote store. You must have drives mapped accordingly to this folder at 
each store or specify a UNC path to the folder. You may receive an error 
message when you enter this path. Ignore the message, it will work once the 
remote store has installed and specifies the same “in folder.” Refer to  
About Store “In” Folders (page 76) for more information about in folders.

8. Select FINISH.
9. Repeat for other remote stores.
10. (Optional) Enter a password if you want to encrypt Store Exchange files for added 

security. 
• Passwords can be up to 15 characters long. If you specify a password at 

Headquarters, then each remote store must enter the same password in their 
Store Exchange preferences. Note that passwords are case sensitive.

11. (Optional) Select the TRACK MULTIPLE STORES IN QUICKBOOKS USING CLASSES   
check-box if you plan to use class tracking in QuickBooks to run profit/loss 
reports for individual stores. 
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• This option is available on this page only if you have already established 
your connection to QuickBooks. To use this feature, class tracking must also 
be turned on in QuickBooks. Refer to Chapter 13 in the Point of Sale User’s 
Guide for more information about this option.

12. Select NEXT to finish this page and continue with the remainder of the Setup 
Interview.

About Store “In” Folders
The "In” folder at each store is where Point of Sale looks for mailbags from other 
stores. Point of Sale also checks this folder for files upon startup and alerts you if new 
exchange mailbags have been received.

If using the network file transfer communication method, other stores should point to 
this folder in their Store Exchange settings. Mailbags received via e-mail or 
removable media can be downloaded to this folder as well. When you run the Store 
Exchange In process, all files in the folder are processed. 

The default in folder for each store is C:\PROGRAM FILES\INTUIT\ QUICKBOOMS POINT OF 
SALE 5.0\STEX\IN\. An alternate in folder can be specified on the Multi-Store  Store 
Exchange page in Point of Sale company preferences. If changing your in folder 
location, be sure other stores using network file transfer change their settings to 
reflect the new location.

Next Steps at Headquarters
1. Complete your setup of Point of Sale, including installing Client Workstations, 

setting advanced options, and entering or importing inventory and other data. 
Refer to Chapters 2 - 4 of this Guide for more information.

2. After remote stores have installed, send an initialization Store Exchange mailbag 
to each. 

Initializing Remote Stores
Once Headquarters has completed the setup of inventory, departments, vendors, and 
company preferences, and remote stores have installed and configured, Headquarters 
sends a Store Exchange mailbag to the remote stores to initialize them with the 
information entered at Headquarters. Remote stores must receive and process this 
mailbag before they can create documents in Point of Sale. 

Once this Store Exchange cycle is completed, all stores have access to inventory and 
are ready to begin normal Point of Sale activities.

Refer to Chapter 13 in the Point of Sale User's Guide for specific instructions for 
completing a Store Exchange.
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Configure at Remote Stores

To configure multi-store settings at a remote store:
1. Follow the procedures outlined in earlier chapters of this Guide to install Point of 

Sale on your Server Workstation selecting SERVER WORKSTATION as the Installation 
Type.

2. Launch Point of Sale and create a company data file, making sure you select  
REMOTE STORE as the Location. 
• You can also specify a store number, but if Headquarters assigns a different 

number, your selection will be overwritten when you receive your 
initialization file from Headquarters later.

3. Use the Setup Interview to configure store-specific settings. When you reach the 
Other Stores page of the interview, enter the License Number, Store Exchange 
(communication) method, and e-mail address or file path to the Server 
Workstation at Headquarters.

   Information Needed

Collect the following information from Headquarters before beginning: 1) the License 
Number from the Server Workstation at Headquarters, 2) the e-mail address, removable 
media information, or “in folder” path (mapped drive or UNC) to the Server Workstation at 
Headquarters, and 3) the Store Exchange password entered at Headquarters (optional).
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Specifying e-mail addresses or file transfer paths:
• If using a desktop e-mail client, enter the e-mail address for Headquarters. If 

you use your default e-mail client’s address book, click the chevron to the 
right of the field to select this address.

• If using web-based e-mail, specify a folder to which Store Exchange files 
will be copied. To send the mailbag to Headquarters, you will have to access 
your web-based e-mail service and follow their instructions for browsing to 
the specified folder and attaching the file.

• If using removable media, enter or browse to the drive or port used. For 
example, to your CD-ROM drive or a USB port.

• If using network file transfer, enter or browse to the store exchange "In 
Folder" of the Point of Sale 5.0 installation on the Server Workstation at 
Headquarters. You must have drives mapped accordingly to this folder at 
each store or specify a UNC path to the folder. Refer to  About Store “In” 
Folders (page 76) for more information about using “in” folders.

Next Steps at Remote Stores
1. Complete your remote setup of Point of Sale, including installing Client 

Workstations, setting up hardware, defining local employees and security, adding 
customers, etc. Refer to Chapters 2 - 4 of this Guide for more information.

2. Receive and process in an initialization Store Exchange mailbag from 
Headquarters. Refer to   (page 78) for more information.

3. After initialization, remote stores may want to review their company preferences 
for the following store-specific settings:
• Default sales tax Location
• Default price for sales

  Do Not Use the Same Network "In” Folder as Other Remote Stores

Remote stores should not all set their In Folder to the same location on a network. When a 
remote store finishes processing a mailbag from Headquarters on a network drive, it deletes 
the mailbag file. If Headquarters were to send a mailbag file to a single network folder, the 
first remote store to process it would then delete the file, leaving no file for the other stores 
to access. Each remote should specify a separate In folder location, and Headquarters 
should send a separate file to each.
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Appendix A Merchant & Gift Card Services
After your account application for the Point of Sale Merchant and/or Gift Card 
Services are approved you will receive your account number(s) from IMS via e-mail. 

Your account number(s), communication settings, and applicable hardware (card 
reader and/or PIN pad), must be configured in Point of Sale preferences before you 
can process card transactions through the services.

Enter Account Number(s) and Specify Service Options
To enter your account number(s) and specify service options:
1. From the Edit menu, select PREFERENCES  COMPANY.
2. Select MERCHANT & GIFT SERVICES from the left-side preferences list.
3. Enter the account number(s) assigned to you in the respective areas of the page 

(Merchant Service and/or Gift Card Service).

4. Make selections for other related options on this page:
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• Merchant Service Options
Do not allow manual transactions that fail address verification. 
When credit card information is manually keyed in, an address 
verification is done to compare the ZIP code entered against bank 
records. If this option is selected, the transaction is not allowed if the ZIP 
codes do not match. Click the WHAT IS THIS link on the screen for more 
information. 
Accept debit/ATM card payments. Select if you want to accept 
payment by debit/ATM cards. A PIN pad device is required to process 
PIN debit transactions; which must be configured in workstation 
preferences. Refer to  Configuring a PIN Pad Device (page 82). 
Allow cash back up to. If processing PIN debit sales, select this option 
if you also want to allow cash back to the customer. Enter the maximum 
cash back amount (limit of $200)

• Merchant & Gift Card Service Option
Automatically print and save receipt upon card approval. This option 
lets you return to servicing the customer while the authorization 
completes and the receipt is automatically printed.

Set Up Communication Options
You can communicate with the Merchant and Gift Card Services to process 
transactions via a secure Internet connection or by a dial-up connection (modem). 
You can also specify which workstation all communication with the services is 
channeled through.   

To set up your Merchant and Gift Card Service communications:
1. In company preferences, select the COMMUNICATION SETUP sub-page under 

MERCHANT & GIFT SERVICES. 
2. Select CHANGE TO THIS COMPUTER if you want all communications to connect 

through this workstation.
If the check-box is already selected and grayed out, all communication is already 
coming through this computer (defaults to the Server Workstation). Refer to  
Using the Merchant and Gift Card Services in a Multi-Workstation 
Environment (page 82) for more information on changing this setting.

3. Select one of the communication options:
• Secure Internet Connection – Provides an IP (Internet Protocol) 

connection through your Internet Service Provider. This option is best for 
users that have a persistent connection to the Internet (such as DSL or a 
cable modem). With a persistent connection, you won’t need a dedicated 
phone line and authorizations are faster than by dialup modem. 
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If you need assistance with setting up your Internet connection, click on the 
INTERNET CONNECTION SETUP button. 

• Direct dial – This connection provides optimum performance for modern 
high-speed dialup modems and supports the default settings of most 
modems. 

4. Select SAVE.

Configuring a Modem
This procedure applies to the direct dial communication option only. Modem setup 
must be done separately on each workstation that will be used for communication 
with the service.

To set up your modem:
1. From the Edit menu, select PREFERENCES  WORKSTATION.
2. Select EQUIPMENT  MODEMS from the left-side preferences list.
3. Select your modem from the drop-down list. 

If your modem is not listed, select ADD MODEM and install it now (refer to your 
modem documentation if additional help is needed with installing the modem). 

4. If you need to dial a “9”or other number to access an outside line, select ADD 
MODEM and then:

a. Select the Dialing Rules tab, choose a location, and then select EDIT.
b. In the appropriate text entry field, enter the number to be dialed to access an 

outside line. Make other changes to the dialing properties as necessary.
c. Select OK twice to save and exit the modem dialog.

5. Select SAVE to save and exit workstation preferences.
6. Exit Point of Sale and reboot your computer.
The first time you run a credit card or debit transaction, you are asked to pick an 
installed modem. Select your modem and then select OK.
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Configuring a PIN Pad Device
You may have configured your PIN pad while completing the Printers & Equipment 
section of the Setup Interview. You would only need to use this procedure if you are 
adding a PIN pad at a later date.

1. Connect the device to your workstation and install the driver, following the 
instructions included with the PIN pad. 

2. From the Edit menu, select PREFERENCES  WORKSTATION.
3. Select PIN PADS from the left-side preference list on the left of the screen (under 

Equipment).

4. Select your model of PIN pad from the drop-down list.
5. Specify the Virtual COM port to which the PIN pad is connected.

Enter the same COM port you set up in Windows Device Manager as you 
completed the installations in Step 1. 
Refer to Windows help for additional information about accessing and using 
Device Manager.

6. Select SAVE.

Using the Merchant and Gift Card Services in a Multi-
Workstation Environment

When operating Point of Sale in a multi-workstation environment, all Merchant and 
Gift Card Service communications for processing go through one workstation, 
regardless of which workstation is accepting the card. By default, Point of Sale sets 
the Server Workstation as the computer used for this communication. 

If you want to channel communications through another workstation, you can change 
this setting on the Communication Setup page in company preferences (the selected 
workstation must have a modem or Internet connection).
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All credit, debit, and gift card transactions, whichever workstation they are performed 
at, will be processed through the selected workstation. When multiple requests occur 
simultaneously, they will be processed in the order received. For direct-dial 
connections, the program will try to complete any queued requests during the same 
connection to the processor, thus eliminating the need to dial out on the modem for 
each request. 

To change the communications workstation:
From the workstation which will handle communications: 

1. Select PREFERENCES  COMPANY from the Edit menu.
2. In the left-side preferences list, select MERCHANT & GIFT SERVICES  

COMMUNICATION SETUP.
3. Select the USE THIS COMPUTER TO CONNECT FOR ALL CREDIT, DEBIT, AND GIFT CARD 

TRANSACTIONS.  
4. Select SAVE.

Using the Merchant and Gift Card Services in a Multi-
Store Environment

With multiple physical locations under the same ownership, you can add additional 
Merchant and Gift Card Service accounts under a single Master Merchant account of 
each type. Each store would process transactions independently but with linked 
accounts, the master account would receive consolidated reporting and account 
statements. 

For more information, contact the QuickBooks POS Merchant and/or Gift Card 
Services support at 800-558-9558.
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Appendix B Configuring Firewalls
Overview
Originally, the term firewall referred to a fire-resistant barrier that was used to prevent 
the spread of fires. Similarly, firewalls in the computer world are also used to prevent 
the spread of something that could be damaging to your system, your information, or 
your privacy. Computers communicate with each other over a network or the Internet 
by sending and receiving information through different ports (channels). Hackers try 
to gain access to other computers through these ports, or they create programs that try 
to do this for them. Firewalls are used to prevent this from happening.

Firewalls monitor communication traveling through your computer’s ports and block 
any communication that they do not know is safe. This provides you with an essential 
component of the protection you need to minimize your exposure to dangers from 
malicious users on the Internet. In order to ensure that desired communication is not 
blocked, you may sometimes need to instruct your firewall program to allow 
communication from certain programs. You may also need to specify the particular 
ports that will be used. How this is done will vary depending upon the particular 
firewall you are using.

There are many different firewalls available to you, and they can be either software or 
hardware firewalls (for example, many routers have built-in firewalls.)

On a typical network, there is a single point of connection to the Internet (such as the 
network server) and this is normally the only point requiring a firewall. Many 
network administrators feel that in such a situation there is no need to activate 
firewalls on every workstation to guard against communication from one workstation 
to another. A good firewall located on the server or other single point of access to the 
Internet is most often viewed as adequate protection. It is recommended that you 
consult a qualified network administrator to review your particular network setup for 
purposes of implementing the best protective measures for your situation.

Point of Sale uses some of the ports on your computer to complete various tasks. Your 
firewall may need to be specifically told that these activities should be allowed. The 
following documentation provides an overview of the various Point of Sale activities 
that may trigger firewall interference, and some examples to assist in configuring the 
most common software firewall programs.
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Firewalls and Point of Sale
Firewalls may need to be configured on the server to allow other workstations to 
access the Point of Sale company data over the network. When a firewall application 
senses a possible threat, it will typically generate a pop-up window that requires user 
interaction to determine how to handle the situation. You may need to be logged into 
Windows as an administrator to see these messages. Examples for some of these pop-
up windows are provided on the following pages. 

If you are on a Client Workstation, accessing the company data on the Server 
Workstation across the network, the pop-up window might occur on the Server 
Workstation and the firewall program on that computer would put the action on 
"hold" until someone on the Server Workstation indicates the correct action to take.

For this reason, when first installing and running Point of Sale on a Client 
Workstation, it is important that the Server Workstation is either easily accessible, or 
that the Server Workstation is manned and that the person manning it is in step-by-
step communication with the person installing the Client Workstation. It is also 
recommended that during installation, you are logged into the computer with 
Windows administrator rights.

Each firewall program presents its interface in a slightly different manner; each 
provides its own phrase for asking what you would like to do regarding the action it 
views as a possible threat. When a window pops up on your computer screen, you will 
see some form of the question, "What do you want to do about this?" That question 
will be followed by a list from which you choose the correct action. This list might 
include such options as allow, grant, deny, block, permit, or some similar instruction. 

Once you have selected to allow, grant or permit the action, there should not be a 
prompt the next time the same action is performed. However, permitting one action 
from one file will not automatically enable all actions from anywhere in the Point of 
Sale program. Permission must be granted separately for each type of action. If 
firewall messages continue to appear, it may be necessary to manually configure the 
firewall to allow access through the required ports.

If you are unable to access the Point of Sale company data and you know you have an 
enabled firewall on the Server Workstation, try the steps provided in the following 
pages for configuring your firewall to allow the connection. 

The following screen shots display possible pop-up windows from two of the most 
popular firewall applications.
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McAfee® Personal Firewall Plus:

Norton™ Personal Firewall:

Ports and Programs

Point of Sale Activities
The following activities in Point of Sale may result in triggering a firewall reaction:

• Communicating between Point of Sale and the Point of Sale database (can 
occur on both the Server and Client workstation.)

• Converting data from a previous version
• Credit/debit/gift card processing 
• Downloading program updates/web installation
• Registration and licensing
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Quick Reference

Configuring Firewalls
If you use a firewall, you may receive an alert that Point of Sale is requesting access 
to the Internet or to connect to other computers. The message may identify any of the 
above as the program that is trying to establish communications, as well as Adaptive 
Server Anywhere Network Server. Select the option to allow access always. This 
should prevent this message in the future.

Default 
Port

Executable Accessed by
(Server/Client 
Workstations)

When Accessed

443 EFTSvr.exe Both Throughout operation

8443 EFTSvr.exe Both Throughout operation
Merchant Service transactions

2638 DataImporter.exe
EFTSvr.exe
QBDBMgrN.exe
QBPOSDBServiceEx.exe

Server only Conversion from previous 
version
Changing currently running 
database (such as switching 
to/from practice mode.)
Startup
Detecting change to 
QBDatabases.ini
Help > Manage my license

46201 EFTSvr.exe
QBDBMgrN.exe
QBPOS.exe

Server only Changing currently running 
database (such as switching 
to/from practice mode.)

46202 EFTSvr.exe
QBDBMgrN.exe
QBPOS.exe

Server only Changing currently running 
database (such as switching 
to/from practice mode.)

2638 QBDBMgr.exe Server only Conversion from previous 
version

8022 setup.exe
QBPOS.exe

Both Web installation
License verification
Throughout operation

8023 setup.exe
QBPOS.exe

Both Web installation
License verification
Throughout operation
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Windows XP Firewall
If you are using the Windows XP integrated firewall, Point of Sale can automatically 
configure the firewall for you.

To automatically configure the Windows XP Internet Connection Firewall 
(ICF):
1. Restart Point of Sale on the server workstation.

The Windows firewall is detected on startup, and Point of Sale prompts you to 
authorize automatic configuration.

2. Select AUTOMATICALLY CONFIGURE to allow automatic configuration.
If you answer NO, you can still manually configure the firewall as described below. 
You will continue to receive the firewall message each time you start Point of Sale 
on the server until the firewall is configured to allow communication.

Windows XP Firewall: Manual Configuration
The instructions below apply specifically to the Windows XP Internet Connection 
Firewall (ICF). Refer to your firewall documentation or help files for assistance as 
necessary or seek the assistance of a qualified computer technician if you need 
additional help.

1. Close Point of Sale on the server workstation.
2. Select START, then CONTROL PANEL, then SYSTEM, and then the COMPUTER NAME 

tab.  Write down the “Full Computer Name,” you will need to enter this later in 
this procedure.

3. Exit to CONTROL PANEL, and then select NETWORK CONNECTIONS. 
4. In the Network Connections window, right-click on the LOCAL AREA NETWORK 

entry and then choose PROPERTIES from the popup menu.
5. Select the ADVANCED tab in the Local Area Connections Properties window.

If the “Protect my computer…” checkbox for the Internet Connection Firewall is 
selected, continue with the next step to configure the firewall. 
If this box is not checked, then the Windows XP firewall is not enabled and is not 
causing your data access problem. Exit the Network Connections window, and 
check to see if you have another firewall enabled. If no firewall can be located, 

  Windows XP Integrated Firewall

When running the Windows XP Integrated Firewall, users may not be prompted unless they 
have Windows administrator rights. Have the user log in as an administrator if Point of Sale 
cannot connect to the database and no firewall alerts appear.
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start Point of Sale and search the help index using keyword ‘troubleshooting’ to 
read other common network issues and solutions.

6. Select SETTINGS.
The Advanced Settings window is displayed. You will add seven new services to 
this list to allow access through the ports Point of Sale needs for network 
communication. 

7. Select ADD.
The Service Settings window, enter a description of the service, the server’s 
computer name, port numbers, and select a checkbox to indicate if the allowed 
traffic is TCP or UDP. Make entries for the first service using the information in 
the first row of the table below (and as shown in the example).

8. Select OK.
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9. Repeat to add the other six services, entering the information from the 
corresponding row in the table.

When done, the Advanced Settings window should have the seven services listed. 
Ensure that the checkbox for all seven is selected, as shown here.

10. Select OK twice and then close the Network Connections window.
11. Restart Point of Sale. 

Service Description External 
Port

Internal 
Port

Traffic

1 Intuit Entitlement Client v2 (TCP) 8023 8023 TCP

2 Intuit Entitlement Service Discovery v2 (UDP) 8022 8022 UDP

3 QBPOS_Practice 46202 46202 TCP

4 QBPOS_Real 46201 46201 TCP

5 QBPOS_TCP 2638 2638 TCP

6 QBPOS_UDP 2638 2638 UDP

7 QBPOSEFTSERVER_TCP 8443 8443 TCP
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McAfee Personal Firewall Plus: Manual Configuration
The configuration panel for McAfee is displayed below. To access this screen, select 
START  PROGRAMS (or ALL PROGRAMS)  MCAFEE  PERSONAL FIREWALL PLUS. Select 
the INTERNET APPLICATIONS tab. 

If any executable file used in the Point of Sale program has the wrong setting, you can 
correct it here. Highlight the executable in the list and select ALLOW FULL ACCESS. If 
the executable file is not on the list, select NEW ALLOWED APPLICATION in order to add 
and configure the file.

The executable files to include are:

• DataImporter.exe
• EftSvr.exe
• QBDBMgr.exe 
• QBDBMgrN.exe 
• QBPOS.exe
• QBPOSDBServiceEx.exe
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Norton Personal Firewall: Manual Configuration
The configuration panel for Norton is displayed below. To access this screen, select 
START  PROGRAMS (or ALL PROGRAMS)  NORTON INTERNET SECURITY  NORTON 
INTERNET SECURITY. Select the PROGRAMS tab. Next, select PERSONAL FIREWALL and 
CONFIGURE. Then select the PROGRAMS tab.

If any executable file used in the Point of Sale program has the wrong setting, you can 
correct it here. Change the INTERNET ACCESS setting to PERMIT ALL. If the executable 
file is not on the list, select ADD in order to add and configure the file.

The executable files to include are:

• DataImporter.exe
• EftSvr.exe
• QBDBMgr.exe 
• QBDBMgrN.exe 
• QBPOS.exe
• QBPOSDBServiceEx.exe
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ZoneAlarm® Pro Firewall: Manual Configuration
The configuration panel for ZoneAlarm Pro is displayed below. To access this screen, 
select START  PROGRAMS (or ALL PROGRAMS)  ZONE LABS  ZONE ALARM PRO. 
Select PROGRAM CONTROL on the right and then select the PROGRAMS tab.

If any executable file used in the Point of Sale program is not checked as TRUSTED, 
you can correct it here by clicking the setting and selecting ALLOW. If the executable 
file is not on the list, select ADD in order to add and configure the file.

The executable files to include are:

• DataImporter.exe
• EftSvr.exe
• QBDBMgr.exe 
• QBDBMgrN.exe 
• QBPOS.exe
• QBPOSDBServiceEx.exe
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General Troubleshooting Tips

Possible Server Workstation Problems 
When encountering connection difficulties on a Server Workstation, the first step is 
for the user to sign onto the machine as a user with Windows administrator rights.

Problems can occur due to any of the following:

• The database application is not running on the Server Workstation
• The Point of Sale company data has been deleted or renamed
• A firewall is interfering with program communications
• TCP/IP not installed
• You are attempting to change the current database being accessed by the 

server while a client is logged into a different database (only one database 
can be run at a time)

• The selected database is not a Point of Sale database
• The Server Workstation is not running the same level or version of Point of 

Sale as another workstation that is currently accessing the database
• The Client Workstation is still logged into the database and thereby 

preventing Restore, Open Database or Rename Database functions
• You have insufficient user rights to create a database or to change the 

currently accessed database
• A needed component or service in Windows has been disabled or deleted

Possible Client Workstation Problems 
When encountering connection difficulties on a Client Workstation, the first step is 
for the user to sign-on to the Client Workstation as a user with Windows administrator 
rights AND that an administrator also sign-on to the Server Workstation.

Problems can occur due to any of the following:

• The Server Workstation is not running
• The database application is not running on the Server Workstation
• The Point of Sale company data has been deleted or renamed
• A firewall is interfering with program communications
• TCP/IP not installed
• An invalid database name has been entered
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• The Client Workstation is not running the same level or version of Point of 
Sale as another Workstation that is currently accessing the database

• More workstations are running than is allowed by license
• A different database is already running (only one database can be run at a 

time)
• The selected database is not a Point of Sale database
• A needed component or service in Windows has been disabled or deleted
• Other network connectivity issue

Port Filters
Windows 2000 and XP allow TCP/IP and UDP ports to be filtered. To determine if 
this is the source of the problem, do the following:

1. Right-click NETWORK PLACES and select PROPERTIES.
2. Right-click LOCAL AREA CONNECTION and select PROPERTIES.
3. Select TCP/IP.
4. Select PROPERTIES.
5. Select ADVANCED.
6. Select OPTIONS.
7. Select TCP/IP FILTERING.
8. Select PROPERTIES.
If Permit Only is checked in any category that is needed for Point of Sale, or required 
ports are not in the list, the same problems will occur as with a firewall.
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Appendix C Remote Data Sharing (RDS)
The procedures below cover installing the RDS applications. Routinely using the 
applications to exchange data requires additional steps, which are outlined in 
Chapter 14. Financial Exchange with QuickBooks in the Point of Sale User’s Guide

Remote Data Sharing (RDS) is an alternative way to configure Point of Sale and 
QuickBooks Financial Software to exchange data across a network. With RDS, your 
QuickBooks Financial Software can be located on any computer on your network, 
other than the Point of Sale Server Workstation. 

RDS allows you to share financial data over the network by installing Server and 
Client applications on the two computers (these are different than the server/client 
applications used for Point of Sale workstation to communicate over the network). 

The two programs communicate through the server/client applications.

  IMPORTANT: RDS Server/Client Relationship

For the purposes of remote data sharing, the computer on which you have QuickBooks 
Financial Software installed is referred to as the “server.” The Point of Sale Server 
Workstation is the “client.

Network

Point of Sale Server Workstation QuickBooks Computer

• Point of Sale program and 
company data file

• RDS Client application

• QuickBooks program and 
company file, must be open 
during exchanges

• RDS Server application

Remote Data Sharing - QuickBooks on Different Networked Computer
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Appendix C:  Remote Data Sharing (RDS)
Comparison of the two Methods of Financial Exchange with 
QuickBooks on another Networked Computer 

Installing RDS

The Server Computer (QuickBooks)
The Remote Data Sharing Server application must first be installed and run on the 
computer with your QuickBooks Financial Software.

To install the Remote Data Sharing Server:
1. Insert the Point of Sale installation CD into your CD-ROM drive. If the 

Installation Wizard launches, cancel out of it.
2. Using Windows Explorer, navigate to your CD-ROM drive and into the EXTRAS 

folder. Double-click RDSSERVER.EXE to begin the installation process. The 
QuickBooks Remote Data Sharing Server application is installed to 
…\QUICKBOOKS\RDS\QBRDSSERVER.EXE. During the installation process, a desktop 
shortcut for the Remote Data Sharing Server application is created.

3. After the installation completes, the Remote Data Sharing Server application 
automatically launches. Select START and leave the Server application running. 

4. Install the Remote Data Sharing Client application using the following 
instructions for installing the Remote Data Sharing Client. 

Installing Financial Software on the 
Server Workstation and on another 
Network Computer

Remote Data Sharing

Benefits 
• Can exchange data with QuickBooks and 

financial company file closed

Benefits 
• Do not have to install QuickBooks on the 

Server Workstation
• Security options can provide more protec-

tion for financial data 

Limitations
• Both programs must be installed on the 

Server Workstation
• If open, QuickBooks must be in multi-user 

mode
• Data exchange blocked if single-user 

license, and another user is in Quick-
Books 

Limitations
• QuickBooks and company file must be 

open during Financial Exchanges
• RDS server application must be running 

on the QuickBooks computer (server)
• Setup and operation is more complex
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The Client Computer (Point of Sale)
The Remote Data Sharing Client application must be installed and run on the Point of 
Sale Server Workstation before proceeding.

To install the Remote Data Sharing Client:
1. Insert the Point of Sale installation CD into your CD-ROM drive. If the 

Installation Wizard launches, cancel out of it.
2. Using Windows Explorer, navigate to your CD-ROM drive and into the EXTRAS 

folder. Double-click RDSCLIENT.EXE to begin the installation process. The 
QuickBooks Remote Data Sharing Client application is installed to 
…\QUICKBOOKS\RDS\QBRDSCLIENT.EXE. During the installation process, a desktop 
shortcut for the application is created.

3. After installation has finished, you will be asked to configure the Remote Data 
Sharing Client by choosing the server computer with which it should 
communicate. Select FIND SERVER (as shown below).

4. A list is displayed of the computers on your network that have the Remote Data 
Sharing Server application currently running. Most users will have only one 
instance of the Remote Data Sharing Server application installed on their network, 
the QuickBooks computer, and this will be the only computer on the list. Select 
this server computer from the list, and then select OK.
If you do not see your server computer listed, make sure the Remote Data Sharing 
Server application is currently running on the QuickBooks computer, and that you 
have selected START from the main screen of the application.
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Appendix C:  Remote Data Sharing (RDS)
5. Select OK from the Setup dialog. Setup is finished and the Remote Data Sharing 
Client automatically closes.

  Server Port Settings

The Remote Data Sharing Server/Client applications must have the same Server Port 
setting. By default, both applications are assigned to the same Server Port. It is 
recommended you keep the default settings. If you change the setting for either application, 
you must mirror that change in the other application. 
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